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notices 

●     notices and acknowledgements 

●     terms and conventions 

●     accessibility 

●     using the onscreen user's guide
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notices and acknowledgements 

notices and acknowledgements 

hewlett-packard company notices 

The information contained in this document is subject to change without notice. 

Hewlett-Packard (HP) makes no warranty of any kind with regard to this material 
including, but not limited to, the implied warranties of merchantability and fitness for a 
particular purpose. 

Hewlett-Packard shall not be liable for any errors or for incidental or consequential 
damages in connection with the furnishing, performance, or use of this material. 

All rights reserved. Reproduction, adaptation, or translation of this material is prohibited 
without prior written permission of Hewlett-Packard, except as allowed under copyright 
laws. 

acknowledgments 

Apple, the Apple logo, AppleTalk, ColorSync, the ColorSync logo, Finder, Mac, Macintosh, 
MacOS, Powerbook, Power Macintosh, and Quickdraw are trademarks of Apple 
Computer, Inc., registered in the U.S. and other countries. 

TrueType is a U.S. trademark of Apple Computer, Inc. 

Adobe and Acrobat are trademarks of Adobe Systems Incorporated. 

Copyright 2002 Hewlett-Packard Company 
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terms and conventions 

terms and conventions 

The following terms and conventions are used in the User's Guide. 

terms 

HP Deskjet printers may be referred to as the HP Deskjet printer, the HP printer, or 
the printer. 

symbols 

The > symbol guides you through a series of software steps. For example: 

Click  File >  Page Setup . 

cautions and warnings 

A Caution indicates possible damage to the HP Deskjet printer or to other equipment. 
For example: 

Caution! Do not touch the print cartridge ink nozzles or copper contacts. Touching these parts 
will result in clogs, ink failure, and bad electrical connections. 

A Warning indicates possible harm to yourself or to others. For example: 

Warning! Keep both new and used print cartridges out of the reach of children.

icons 

A Note icon indicates that additional information is provided. For example: 

For great results use HP products. 

A Printing instructions icon indicates that a description of print options is available in 
the onscreen user's guide. For example: 

For a description of available print options, click the appropriate operating 
system:
Mac OS 8.6, 9.x, or X Classic or Mac OS X.
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accessibility 

accessibility 

For accessibility information, visit Apple's Website at http://www.apple.com/disability/. 
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using the onscreen user's guide 

using the onscreen user's guide 

This onscreen user’s guide is viewed through Adobe Acrobat Reader version 4.0 or 
greater. 

Use the following tools to view and navigate the onscreen user's guide:

●     View Buttons: Click these buttons to change page views: 

 View the page in actual size 

 Fit the page in the window 

 Fit the page width in the window 

●     Zoom:  Use to zoom in on a page. 

●     Bookmarks: Click a bookmark to view a topic. 

●     Navigation Buttons: Click these buttons to navigate: 

 Go to the first page of the document 

 Go backward one page 

 Go forward one page 

 Go to the last page of the document 

 Go to the previous view 

 Go to the next view 
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special features

Congratulations! You have purchased an HP Deskjet printer that is equipped with several 
exciting features:

Photo print cartridge: Great performance, with a photo print cartridge that prints 
stunning true-to-life photos.

Digital photo printing: Enhanced digital photo printing capabilities.

Borderless printing: Photos and cards print to the edges of the paper with borderless 
printing.

Reserve mode: Reserve mode lets you continue printing with one print cartridge when 
the other print cartridge has run out of ink.

Auto-On and Auto-Off: Enable Auto-Off to place the printer into a low-power, energy-
efficient mode after it has been idle for 30 minutes. The printer turns on automatically 
when you print a file. 

Poster Printing: Poster printing lets you print a poster on multiple pages which can be 
taped together.  

 

Poster printing is not available in Mac OS X. 
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getting started 

getting started 

●     printer features 

●     buttons and lights 

●     paper trays 

●     print cartridges 

●     reserve mode 

●     automatic paper-type sensor 

●     connectivity 
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printer features 

printer features 

The HP printer has several features to make printing easier and more efficient. 

To view a printer feature, click below on the name of the feature. 

 

1. buttons and lights 

2. paper trays 

 

1. reserve mode 

2. print cartridges 

3. automatic paper-type sensor 
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printer features 

 

1. connectivity 
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buttons and lights

buttons and lights

The printer buttons let you turn the printer on and off, cancel a print job, or resume 
printing. The lights give you visual cues about the status of the printer.

 

1. Cancel button 2. Print Cartridge Status light 
3. Resume button and light 4. Power button and light

cancel button

Pressing the Cancel button cancels the current print job.

print cartridge status symbol and light

The Print Cartridge Status light turns on or flashes when a print cartridge needs service.

resume button and lights

The Resume light flashes when an action is required such as loading paper or clearing a 
paper jam. When the problem is solved, press the Resume button to continue printing.

power button and light

The Power button turns the printer on and off. It may take a few seconds for the printer 
to turn on after pressing the Power button. The green light next to the Power button 
flashes when the printer is processing.

Caution! Always use the Power button on the front of the printer to turn the printer on and off. 
Using a power strip, surge protector, or a wall-mounted switch to turn the printer on and off 
may cause printer failure.
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paper trays

paper trays 

The printer has two paper trays: an In tray and an Out tray. The Out tray contains a slot 
for single envelope printing.

 

1. Out tray 2. In tray 3. single envelope slot

In tray

The In tray holds paper or other media to be printed.

You can print different sizes of media by sliding the paper guides in and out.

 

1. paper width guide 2. paper length guide

Out tray

Printed pages are deposited in the Out tray.

Raise the Out tray to load paper. 
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paper trays

1. Out tray up

Remove the Out tray to load small media, such as index cards. 

 

Replace the Out tray before printing.

Out tray extension - Pull out the Out tray extension when printing a large number of 
pages. Also pull out the extension when printing in draft mode to prevent the paper from 
falling out of the tray. When the print job finishes, push the tray extension into its 
storage slot. 

 

1. Out tray extension
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print cartridges

print cartridges

Three print cartridges can be used with your printer:

●     black print cartridge

●     tri-color print cartridge

●     photo print cartridge

 

1. black print cartridge 2. tri-color print cartridge 3. photo print cartridge

print cartridge selection

print cartridge selection 
number 

product 
number 

black 
 

c6656a 

tri-color 
 

c6657a 

photo print 
 

c6658a 

For installation instructions, see replacing print cartridges.

For storage instructions, see maintaining print cartridges.

For recycling instructions, see print cartridge recovery.

 

For print cartridge ink capacity, see the information included in the print 
cartridge packaging.
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automatic paper-type sensor

automatic paper-type sensor

The Automatic Paper-Type Sensor determines the correct paper type and adjusts the 
print settings for most paper or media placed in the paper tray. Automatic is the 
default option in the Print dialog box.

This feature, particularly when used with HP paper and media, provides better printing 
results. 

When the Automatic default option is selected, the Automatic Paper-Type Sensor is 
engaged. The printer scans the first page of a document with a blue optical sensor light 
to determine the best paper type setting. Once determined, the page is printed.

For more information, see using the automatic paper type sensor.
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reserve mode

reserve mode

Reserve mode allows the printer to operate using only one print cartridge. It is initiated 
when a print cartridge is removed from the cradle.

1. remove print cartridge to initiate reserve mode 

reserve mode output

Printing in reserve mode slows the printer and affects the quality of printouts.

when only this print cartridge 
is installed... the result is...

black print cartridge Colors are printed as grayscale.

tri-color print cartridge 

Colors print but black is grayed and is 
not a true black.

Printing a black text or monochrome 
document with a tri-color print 
cartridge increases printing time.

photo print cartridge Colors are printed as grayscale.

file:///C|/Projects/Newport/Mac_UG_ROW/ug_reservemode_fs.html (1 of 2) [5/9/2002 10:23:56 AM]

18



reserve mode

 
exiting reserve mode

Install two print cartridges in the printer to exit the reserve mode.

For instructions on installing a print cartridge, see replacing print cartridges.
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connectivity

connectivity

The printer offers two options for connectivity:

●     USB 

●     network 

USB

The printer can connect to the computer with a USB cable. 

 

For instructions on connecting the printer with a USB cable, see the Setup poster that 
came with the printer.

network

The printer can be connected to a network with an HP JetDirect External Print Server 
that supports an AppleTalk connection. 
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printing 

printing 

Click the following topic below to view an explanation of the printer software: 

●     using printer software with Mac OS 8.6, 9.x, and X Classic 

●     using printer software with Mac OS X 

Click the appropriate topic below to view instructions on printing functions: 

●     printing a document 

●     printing digital photographs 

●     auto-on and auto-off feature 

●     two-sided printing 

●     using the automatic paper-type sensor 

●     borderless printing 

Click the appropriate topic below to view instructions for printing on different paper 
types: 

●     plain paper 

●     envelopes 

●     transparencies 

●     labels 

●     index cards and other small media 

●     Hagaki cards 

●     photographs 

●     greeting cards 

●     posters 

●     banners 

●     iron-on transfers 
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using printer software with Mac OS 8.6, 9.x, and X Classic

using printer software with Mac OS 8.6, 9.x, and X Classic

The printer is controlled by software installed on your computer. Use the printer software to perform the 
following tasks:

●     choosing the printer 

●     printing from the computer's desktop 

●     checking the printer status 

●     using the page setup dialog box 

●     using the print dialog box 

●     viewing and changing the status of a print job

Mac OS X Classic is a Mac OS X feature that allows applications built for Mac OS 9.x to run on a 
Mac OS X computer. Mac OS X Classic applications have a Mac OS 9.x interface. 

choosing the printer

Setting the printer as your computer's default printer will automatically route all print jobs to that printer.

You can select another printer for a particular document; however, switching printers may affect a 
document's formatting and pagination. If you select a printer, always check the document for changes in 
formatting and pagination before printing.

setting up the printer

Follow these steps to setup the printer:

1.  Select Chooser from the Apple menu.

2.  Click the hp printer icon in the left side of the Chooser dialog box.
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using printer software with Mac OS 8.6, 9.x, and X Classic

 

3.  Click hp deskjet printer in the right side of the Chooser dialog box.

4.  Do one of the following, depending on how the computer and the printer are connected:

❍     USB: Go to step 5.

❍     AppleTalk: Click the Setup button, then select the correct printer type.

5.  Close the Chooser.

selecting a default printer

After setting up the printer with the Chooser, use one of the following methods to select it as the default 
printer:

●     Click the menu bar printer icon at the top of the screen, then select the printer name.

●     Click the control strip printer icon, then select the printer name.

●     Click the desktop printer icon, then choose Set Default Printer from the Printing menu.

printing from the computer's desktop

Desktop printing is useful when you want to print a number of documents at once or print a document 
that is formatted for a particular printer.

Use one of the following methods to print from the desktop:

●     Drag the icons of the documents you want to print to the printer icon on the desktop.

●     Select the icons of the documents you want to print, then select File > Print. Select the options 
you want from the Print dialog box, then click the OK button.

Desktop printing is not supported in Mac OS X Classic. 
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using printer software with Mac OS 8.6, 9.x, and X Classic

checking the printer status

The printer desktop icon shows you the status of the printer.

icon meaning

 
Printer is idle and set as the default printer.

 
Printer is idle and not set as the default printer.

 
Printing on the default printer.

 
Printing stopped on the default printer.

 
Error on the default printer.

 
The printer driver is not available.

using the page setup dialog box

Use the Page Setup dialog box to modify a document's layout.

displaying the page setup dialog box

To display the Page Setup dialog box, open the software program used to create the document, then 
select File > Page Setup.

description

The following options are available on the Page Setup dialog box:
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using printer software with Mac OS 8.6, 9.x, and X Classic

 

1.  Menu: Choose one of the following: 

❍     Page Attributes: To set print options for the document. 

❍     Application Attributes: To set print options specific to the application being used.

2.  Page Size: Select the paper size. 

3.  Scaling (%): Reduce or enlarge a document image: 

❍     Enter a number from 25-99 to reduce a document image. 

❍     Enter a number from 101 to 400 to enlarge a document image.

4.  Orientation: Click the appropriate icon for the page orientation. 

5.  Mirror Image: Click to print a mirror image. 

6.  Rotate 180º: Click to rotate the page image 180 degrees top to bottom (turns the original upside 
down). 

7.  Two-Sided Safe Margins: Click to adjust page margins for two-sided printing 

8.  Borderless Printing: See borderless printing.

using the print dialog box

Use the Print dialog box to modify print settings for the document you are printing. The options displayed 
depend on the panel selected.

displaying the print dialog box

To display the Print dialog box, open the document you want to print, then select File > Print.

menu and buttons

Use the menu and buttons for these functions:
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using printer software with Mac OS 8.6, 9.x, and X Classic

1.  Panel Menu: Click the menu to select different panels: General, Paper Type/Quality, Layout, 
Color, Digital Photography, Background Printing, or an application-specific panel. 

2.  Settings Menu: Click to select one of the following: 

❍     Select a pre-defined or Default set of print settings. 

❍     Create or edit a set of print settings.

3.  Preview: Click to see a preview of the printed document. 

4.  Cancel: Click to close the Print dialog box without printing. 

5.  OK: Click to print the document.

general

Use the General panel for these functions:
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using printer software with Mac OS 8.6, 9.x, and X Classic

 

1.  Copies: Enter the number of copies to be printed. 

2.  Collate: Select to collate if printing multiple copies. 

3.  Print Back to Front: Select to print the last sheet first. 

4.  Pages: Choose one of the following: 

❍     Click All to print the entire document. 

❍     To print a range of pages, click From then enter the first page to print in the From: box 
and the last page to print in the To: box.

paper type/quality

Use the Paper Type/Quality panel for these functions:
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using printer software with Mac OS 8.6, 9.x, and X Classic

 

1.  Paper Group: Select the category of paper used, such as plain paper, or select automatic to 
engage the Automatic Paper-Type Sensor. 

2.  Paper Type: Select the specific type of paper used. The available options vary according to the 
Paper Group selected. 

3.  Quality: Quality of printout. There are five options to choose from: Best, Normal, Everyday, 
FastDraft and High Resolution Photo. Best provides the best print quality at the slowest 
printing speed. The print speed increases and the print quality lessens with Normal, Everyday, and 
FastDraft. FastDraft provides draft quality at the fastest printing speed.  High Resolution photo is 
available for some photo papers. 

4.  Ink: Click to set the ink dry time and density.

layout

Select the Layout panel for page layout options:
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using printer software with Mac OS 8.6, 9.x, and X Classic

 

1.  Layout Menu: Choose one of the following combinations: 

❍     Multiple Pages Per Sheet/Pages Per Sheet: Select these options for most printing 
jobs. You can choose the number of pages to appear on each sheet of paper: 1 
(Normal), 2, 4, 6, 9, or 12 up. 

❍     Booklet: Select Booklet to print a booklet, then select the size of paper to use. You can 
print the booklet from left to right or right to left. 

❍     ZoomSmart/Print On: Select ZoomSmart to scale from one paper size to another . for 
example, to shrink a legal-size document to print on letter/A4 paper. 

❍     Tiling: Select to print one image on several sheets of paper. Use the the Tiling Size 
option to select how many pages to print the image on.

2.  Print Border: If more than one page is being printed on a sheet of paper, select Print Border to 
print a border around each page on the sheet. 

3.  Print Both Sides: Select for two-sided printing. 

4.  Binding: Click the icon for Book (binding at the side), or Tablet (binding at the top) when using 
two-sided printing. 

5.  Manual/Automatic: Select Manual for manual two-sided printing. You can select Automatic 
only if you have installed the optional HP Two-Sided Printing Accessory (duplexer).

digital photography

For a description of the Digital Photography panel, see printing digital photographs.

 

color
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using printer software with Mac OS 8.6, 9.x, and X Classic

Use the Color panel for these functions:

 

1.  Image: Choose one of the following: 

❍     ColorSmart III: Prints optimum color quality. 

❍     ColorSync: Prints using the ColorSync matching system. 

❍     Grayscale: Prints in shades of gray. 

❍     Black & White: Prints in black and white without shades of gray.

2.  Saturation: Slide to adjust the color saturation. 

3.  Brightness: Slide to make the image lighter or darker. 

4.  Color Tone: Slide to adjust coolness and warmth.

background printing

Use the Background Printing panel for these functions:
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using printer software with Mac OS 8.6, 9.x, and X Classic

 

1.  Print In: Choose one of the following: 

❍     Foreground: Faster printing. 

❍     Background: Allows you to use the computer while the document prints.

2.  Print Time: Choose one of the following: 

❍     Urgent: Begin printing as soon as possible. 

❍     Normal:  Print job will be sent to queue and printed in order. 

❍     Print at: Specify a date and time to print the document. 

❍     Put document on hold: Hold the document in the desktop printer to print at a later 
time.

viewing and changing the status of a print job

When printing a document with background printing, use the Print Status dialog box to see the status of 
the document as it is printing.

displaying the print status dialog box

Double-click the hp printer icon on the desktop to display the Print Status dialog box.

using the print status dialog box

The following options are available on the Print Status dialog box:
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using printer software with Mac OS 8.6, 9.x, and X Classic

 

1.  Control Buttons: Select a print job in the print queue, then click one of the following buttons to 
control printing: 

Pause a print job.

Restart printing.

Set the print time.

Delete a print job. 

2.  Column Titles: Click a column title to sort print jobs. 

3.  Print Queue: Select a print job, then drag it to a new position in the print queue.
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using printer software with Mac OS X

using printer software with Mac OS X

The printer is controlled by software installed on the computer. For instructions on using the printer 
software, select one of the following topics:

●     using the page setup dialog box 

●     using the print dialog box 

●     using the print center

Mac OS X Classic is a Mac OS X feature that allows applications built for Mac OS 9.x to run on a Mac 
OS X computer. Mac OS X Classic applications have a Mac OS 9.x interface. For more information, 
see using printer software with Mac OS 8.6, 9.x, and X Classic. 

using the page setup dialog box

Use the Page Setup dialog box to modify a document's layout.

displaying the page setup screen

To display the Page Setup screen, open the software program used to create the document, then select File 
> Page Setup.

description

The following options are available on the Page Setup dialog box.

1.  Settings: Choose one of the following: 

❍     Page Attributes: To set print options for the document. 

❍     Application Attributes: To set print options specific to the application being used. 
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using printer software with Mac OS X

❍     Summary: To view the print settings for the document. 

❍     Borderless Printing: See borderless printing .

2.  Format for: Select the printer name. 

3.  Paper Size: Select the paper size. 

4.  Orientation: Click the appropriate icon for the page orientation. 

5.  Scale: Reduce or enlarge a document image: 

❍     Enter a number from 25-99 to reduce a document image. 

❍     Enter a number from 101 to 500 to enlarge a document image.

using the print dialog box

Use the Print dialog box to modify print settings for the document you are printing. The options displayed 
depend on the panel selected.

displaying the print dialog box

To display the Print dialog box, open the document you want to print, then select File > Print.

menu and buttons

Use the menu and buttons for these functions:

 

1.  Printer: If necessary, select the printer. 

2.  Saved Settings: Select a group of saved print options. 

3.  Panel Menu: Click the menu to select different panels: Copies and Pages, Layout, Output Options, 
Paper Type/ Quality, Two Sided Printing, an application-specific panel, or a summary of print settings 
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using printer software with Mac OS X

for the document. 

4.  ?: Click to view Mac Help. 

5.  Preview: Click to see a preview of the printed document. 

6.  Cancel: Click to close the Print dialog box without printing. 

7.  Print: Click to print the document.

copies and pages

Use the Copies and Pages panel for these functions:

1.  Copies: Enter the number of copies to be printed. 

2.  Collated: Select to collate if printing multiple copies. 

3.  Pages: Choose one of the following: 

❍     Click All to print the entire document. 

❍     To print a range of pages, click From then enter the first page to print in the From: box and 
the last page to print in the To: box.

layout

Use the Layout panel for these functions:
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using printer software with Mac OS X

 

1.  Pages per Sheet: Select how many pages to print on each sheet of paper. 

2.  Layout Direction: Select the option for how multiple pages are arranged on a sheet of paper. 

3.  Border: Select the border to appear around each page.

output options

Use the Output Options panel for these functions:

 

1.  Save as File: Select to print to file. 

2.  Format: Select either PDF or PS (PostScript).
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using printer software with Mac OS X

paper type/quality

Use the Paper Type/Quality panel for these functions:

1.  Paper : Click to select the following options: 

❍     Paper Type: Select the paper type desired or select automatic to engage the Automatic 
Paper-Type Sensor. 

❍     Quality: Select one of the following print speed and quality options: Best, Normal, 
Everyday, FastDraft and High Resolution Photo. Best provides the best print quality at 
the slowest printing speed. The print speed increases and the print quality lessens with 
Normal, Everyday, and FastDraft. FastDraft provides draft quality at the fastest printing 
speed.  High Resolution photo provides 4800 dpi printing (available with certain photo paper 
types when Best mode is selected).  

❍     Color: Select the color setting.
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using printer software with Mac OS X

2.  Color Options : Click to set saturation, brightness, and color tone. 

3.  Digital Photos: See printing digital photographs . 

4.  Ink: Click to set ink dry time and density.

two sided printing

The Automatic Two-Sided Printing Accessory must be attached to the back of the printer to print a 
two-sided document with Mac OS X. 

Use the Two Sided Printing panel for these functions:

1.  Print Both Sides: Check this box to print a two-sided document. 

2.  Binding: Select the appropriate binding: 

Book binding.

Tablet binding. 

using the print center

Use the Print Center to:
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using printer software with Mac OS X

●     Manage available printers 

●     Select a default printer 

●     Add a printer 

●     Manage print jobs

displaying the print center

Follow these steps to display the Print Center:

1.  Click Applications in the Finder window. 

2.  Select the Utilities folder. 

3.  Select the Print Center icon.

managing available printers

Use the Print Center to manage available printers:

1.  Name Column: Click a printer name to select the printer. 

2.  Blue Bullet: Indicates default printer. 

3.  Delete: Select a printer, then click Delete to remove the printer from the computer. 

4.  Add Printer: See adding a printer.
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using printer software with Mac OS X

selecting a default printer

Follow these steps to set the printer as the computer's default printer:

1.  Open the Print Center. 

For instructions on opening the Print Center, see using the print center . 

2.  Click the printer name. 

3.  Do one of the following: 

❍     Select Printers > Make Default 

❍     Press Command + d 

A blue bullet appears next to the printer name to indicate that it is the default printer.

adding a printer

Follow these steps to add a printer to your computer:

1.  Open the Print Center. 

For instructions on opening the Print Center, see using the print center.

2.  Click the Add Printer button. 

The Add Printer List dialog box appears.

 

3.  Select USB or AppleTalk from the menu. 

4.  Select the printer name from the printer list. 

5.  Click the Add button.
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using printer software with Mac OS X

managing print jobs

Use the Print Center to manage print jobs.

1.  Open the Print Center. 

For instructions on opening the Print Center, see using the print center.

2.  Select the printer. 

The print queue appears.

 

3.  Click a print job to select it. 

4.  Use the buttons to manage the print job as desired: 

❍     Delete: Cancels the selected print job. 

❍     Hold: Pauses the selected print job. 

❍     Resume: Restarts a paused print job.
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printing a document

printing a document 

For printing instructions, select the appropriate option: 

●     My computer runs Mac OS 8.6 or 9.x 

●     I am using a Mac OS 9.x application on a Mac OS X 
computer

Mac OS 8.6, 9.x, and X 
Classic

I am using an application built for Mac OS X Mac OS X

Mac OS 8.6, 9.x, and X Classic 

The following instructions provide the most common method of selecting page layout 
and print options. The software program you are using may vary from the method 
described. 

controlling page layout

1.  Open the file you want to print. 

2.  Click File > Page Setup to display the Page Attributes screen to select paper 
size, scaling, borderless printing, orientation, mirror image, rotate 180º, and Two-
Sided Printing. 

3.  Click OK to save the page layout options.

selecting print options

1.  Open the file you want to print. 

2.  Click File > Print to display the Print dialog box. 

3.  Use the General panel to select the number of copies to print, which pages are to 
be printed, and the print order on this screen. 

4.  Select Paper Type/Quality to choose print quality options, paper group, paper 
type, ink density, and drying time. 

5.  Select Layout to choose multiple pages per sheet and two-sided printing. 

6.  Select Digital Photography to choose options for printing digital photographs. 

7.  Select Color to choose options for color, grayscale, black and white printing, and 
image and text resolution. 

8.  Select Background Printing to choose foreground or background print options 
and print time. 

9.  Click OK to print the document.
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printing a document

For a description of the Macintosh printer software, see using printer software with Mac 
OS 8.6, 9.X, and X Classic. 

Mac OS X

The following instructions provide the most common method of selecting page layout 
and print options. The software program you are using may vary from the method 
described. 

controlling page layout

1.  Open the file you want to print. 

2.  Click File > Page Setup to display the Page Setup screen to select the printer, 
paper size, scaling, borderless printing, and orientation. 

3.  Click OK to save the page layout options.

selecting print options

1.  Open the file you want to print. 

2.  Click File > Print to display the Print dialog box. 

3.  Select the Copies and Pages panel to select the number of copies to print and 
which pages are to be printed. 

4.  Select Layout to choose multiple pages per sheet, layout order, and borders. 

5.  Select Output Options to save the file as a PDF or PostScript file. 

6.  Select Paper Type/Quality to choose print quality options, paper type, print 
mode, and digital photography options. 

7.  Select Two Sided Printing to print a two-sided document and choose the 
binding options. 

8.  Select Summary to view the print settings for the document. 

9.  Click Print to print the document.

For a description of the Mac OS X printer software, see using printer software with Mac 
OS X. 
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two-sided printing

two-sided printing

For printing instructions, select the appropriate option: 

●     My computer runs Mac OS 8.6 or 9.x 

●     I am using a Mac OS 9.x application on a Mac OS X computer Mac OS 8.6, 9.x, and X Classic

I am using an application built for Mac OS X Mac OS X

The Automatic Two-Sided Printing Accessory must be attached to the back of the printer to 
print a two-sided document with Mac OS X. 

two-sided printing with Mac OS 8.6, 9.x, and X Classic 

Follow these instructions to print a two-sided document:

1.  Open the Print dialog box, then select the Layout panel. 

2.  Select  Print Both Sides. 

3.  Select Manual. 

4.  Select the appropriate binding: 

Book binding.
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two-sided printing

Tablet binding. 

5.  Change any other desired print settings, then click OK . 

6.  The printer automatically prints odd-numbered pages first. Once the odd-numbered pages are 
printed, a message appears prompting you to reload the paper so that the even-numbered 
pages can be printed. 

 

Book binding

 

Tablet binding

7.  Reload the paper, then click Continue.

two-sided printing with Mac OS X

To print a two-sided document on a Mac OS X computer, the Automatic Two-Sided Printing Accessory 
must be attached to the printer.  If the Automatic Two-Sided Printing Accessory is not attached to the 
printer, you cannot print a two-sided document. 

1.  Open the Page Setup dialog box. 

2.  Click the  Paper Size menu, then select a two-sided paper size. 

3.  Click OK. 

4.  Open the Print dialog box, then select the Two-Sided Printing panel. 
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two-sided printing

5.  Select Print Both Sides. 

6.  Select the appropriate binding. 

Book binding.

Tablet binding. 

7.  Change any other desired print settings, then click Print. 

Manual two-sided printing is not available in Mac OS X. 
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printing digital photographs

printing digital photographs

The hp deskjet printer has several features to improve the print quality of your digital photographs.

For printing instructions, select the appropriate option: 

●     My computer runs Mac OS 8.6 or 9.x 

●     I am using a Mac OS 9.x application on a Mac OS X computer Mac OS 8.6, 9.x, and X Classic

I am using an application built for Mac OS X Mac OS X

Mac OS 8.6 and 9.x

accessing the digital photography options

1.  Open the Print dialog box. 

2.  Select the Digital Photography panel. 

using the hp digital photography options dialog box

Use the HP Digital Photography Panel to set these options:

 

1.  Contrast Enhancement: Adjust contrast to preference. Click Automatic  to allow the printer driver 
to automatically balance contrast. 

2.  Digital Flash: Lighten dark images. Click Automatic to allow the printer driver to automatically 
balance lightness and darkness. 

3.  Sharpness: Adjust image sharpness to preference. Click Automatic to allow the printer driver to 
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printing digital photographs

automatically balance sharpness. 

4.  Smoothing: Adjust distortion to preference. Click Automatic to allow the printer driver to 
automatically balance smoothing. 

5.  SmartFocus: Click On to allow the printer driver to automatically focus images. 

Mac OS X

accessing the digital photography options

1.  Open the Print dialog box. 

2.  Select the Printer Type/Quality panel. 

3.  Click the Digital Photo tab.

using the hp digital photography options

 

1.  Use the HP Digital Photography tab to set these options:

❍     Contrast Enhancement: Adjust contrast to preference. Click Auto to allow the printer driver 
to automatically balance contrast. 
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printing digital photographs

❍     Digital Flash: Lighten dark images. Click Auto to allow the printer driver to automatically 
balance lightness and darkness. 

❍     Sharpness: Adjust image sharpness to preference. Click Auto to allow the printer driver to 
automatically balance sharpness. 

❍     Smoothing: Adjust distortion to preference. Click Auto to allow the printer driver to 
automatically balance smoothing. 

❍     SmartFocus: Click On to allow the printer driver to automatically focus images. 
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auto-on and auto-off feature

auto-on and auto-off feature

enabling auto-on

Auto-On is a default feature of the printer. The printer automatically turns on when you 
print a file.

enabling auto-off

Enable the auto-off feature to place the printer in a low-power, energy-efficient mode 
after it has been idle for 30 minutes.

To enable the auto-off feature, open the hp inkjet utility, select the Configuration 
panel, then follow the onscreen instructions. 

For instructions on using the hp inkjet utility, see using the hp inkjet utility.
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using the automatic paper-type sensor

using the automatic paper-type sensor

For a description of the Automatic Paper-Type Sensor feature, see Automatic Paper-Type 
Sensor.

turning off the automatic paper-type sensor

1.  Open the Print dialog box. 

2.  Select the Paper Type/Quality panel. 

3.  Do one of the following: 

❍     Mac OS 8.6, 9.x, or X Classic: Select a paper group other than 
Automatic 

❍     Mac OS X: Select a paper type other than Automatic

4.  Do one of the following: 

❍     Mac OS 8.6, 9.x, or X Classic: Click OK 

❍     Mac OS X: Click Print

For a description of available print options, click the appropriate operating 
system:
Mac OS 8.6, 9.x, or X Classic or Mac OS X.

turning on the automatic paper-type sensor

1.  Open the Print dialog box. 

2.  Select the Paper Type/Quality panel. 

3.  Do one of the following: 

❍     Mac OS 8.6, 9.x, or X Classic: Select Automatic in the Paper Group 
box 

❍     Mac OS X: Select Automatic in the Paper Type box

4.  Do one of the following: 

❍     Mac OS 8.6, 9.x, or X Classic: Click OK 

❍     Mac OS X: Click Print
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borderless printing

borderless printing

Borderless printing lets you print to the edges of small media such as cards and photos.

4 x 6 inch photo paper with tear-off tabs: When you print on this media, the 
printout is completely borderless after the tear-off strip is removed.

 

A6 cards, and 4 x 6 inch photos without tear-off tabs: When you print on any of 
these media types, the printout is borderless on three sides with a narrow border on the 
bottom.

 

printing guidelines

selecting paper: Use the following paper types for borderless printing. 

●     Photo 4 x 6 in with tab 

●     Photo 4 x 6 in 

●     A6 Card 105 x 148.5 mm
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borderless printing

selecting image size: Open the image file in a software application and assign the 
image size. The size corresponds to the paper size on which you want to print the 
image. Before printing, select the appropriate paper size and, for OS 8.6, 9.x, or X 
Classic, check the Borderless Printing box on the Page Setup dialog.

preparing to print

Load the paper into the printer according to the instructions for the paper type.

●     photographs 

 

loading and printing photo paper with tear-off tab: Remove the 
Out tray and, holding the tabbed edge, slide the HP Borderless Photo 
paper printable or glossy–side down, into the In tray. Replace the Out 
tray. 

●     index cards and other small media

●     My computer runs Mac OS 8.6 or 9.x 

●     I am using a Mac OS 9.x application on a Mac OS X 
computer 

Mac OS 8.6, 9.x, and X 
Classic

I am using an application built for Mac OS X Mac OS X

borderless printing with Mac OS 8.6, 9.x, and X Classic

1.  Open the Page Setup dialog box. 

2.  Select the appropriate page size. 

3.  Click Borderless Printing. 

4.  Click OK. 

5.  Open the Print dialog box. 

6.  Select any other desired print settings. 

Click a two-sided printing option when appropriate. Clicking a two-sided 
printing option limits the options available in the paper type menu. For 
example, photos are only printed on one side.

7.  After selecting the print settings, click OK.

borderless printing with Mac OS X

1.  Open the Page Setup dialog box. 

2.  Select a borderless printing paper size in the Paper Size box. 
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borderless printing

3.  Click OK. 

4.  Open the Print dialog box. 

5.  Select any other desired print settings. 

Click a two-sided printing option when appropriate. Clicking a two-sided 
printing option limits the options available in the paper type menu. For 
example, photos are only printed on one side.

6.  After selecting the print settings, clickOK.
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plain paper

plain paper

preparing to print

1.  Raise the Out tray. 

2.  Slide out both paper guides. 

3.  Place up to 100 sheets of paper in the In tray. 

 

4.  Slide the paper guides firmly against the paper. 

5.  Lower the Out tray. 

printing on plain paper 

●     My computer runs Mac OS 8.6 or 9.x 

●     I am using a Mac OS 9.x application on a Mac OS X 
computer

Mac OS 8.6, 9.x, and X 
Classic

I am using an application built for Mac OS X Mac OS X

printing on plain paper with Mac OS 8.6, 9.x, and X Classic

1.  If necessary, open the Page Setup dialog box and select the page size, scaling, or 
orientation options. 

2.  Open the Print dialog box, then select the following settings: 

panel setting

Paper Type/Quality
Paper Group: Automatic or Plain 
Paper

3.  Select any other desired print settings. 
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plain paper

4.  After you have selected the print settings, click OK.

printing on plain paper with Mac OS X

1.  If necessary, open the Page Setup dialog box and select the printer, page size, 
scaling, or orientation options. 

2.  Open the Print dialog box, then select the following settings: 

panel setting

Paper Type/Quality 
Paper Type: Automatic or Plain 
Paper

3.  Select any other desired print settings. 

4.  After you have selected the print settings, click Print.

For a description of available print options, click the appropriate operating 
system:
Mac OS 8.6, 9.x, or X Classic or Mac OS X.
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envelopes

envelopes

Print a single envelope using the envelope slot, or print multiple envelopes using the 
paper tray.

printing guidelines

●     Never place more than 15 envelopes in the In tray at one time. 

●     Avoid using envelopes that have clasps or windows. 

●     Avoid using envelopes that are shiny or embossed; envelopes with thick, 
irregular, or curled edges; or envelopes that are wrinkled, torn, or otherwise 
damaged. 

●     Align the envelope edges before inserting them in the paper tray.

preparing to print a single envelope

1.  Place the envelope with the flap side on the left and facing up into the single 
envelope slot.

2.  Push the envelope forward until it stops.

 

preparing to print a stack of envelopes

1.  Remove the Out tray. 

 

2.  Slide out both paper guides and remove all paper from the In tray. 

3.  Place no more than 15 envelopes—with the flap side on the left and facing up—in 
the In tray. 
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envelopes

 

4.  Push the envelopes forward until they stop. 

5.  Slide the paper guides firmly against the edges of the envelopes. 

6.  Replace the Out tray. 

 

printing the envelopes 
●     My computer runs Mac OS 8.6 or 9.x 

●     I am using a Mac OS 9.x application on a Mac OS X 
computer

Mac OS 8.6, 9.x, and X 
Classic

I am using an application built for Mac OS X Mac OS X

printing envelopes with Mac OS 8.6, 9.x, and X Classic

1.  Open the Page Setup dialog box, then select the following settings: 

panel setting

Page Attributes 

Page Size: Appropriate envelope size

Orientation: Appropriate envelope 
orientation

2.  Click OK. 

3.  Open the Print dialog box, then select the following settings: 
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envelopes

panel setting

Paper Type/Quality 

Paper Group: Automatic, Plain 
Paper or Inkjet Paper

Paper Type: Appropriate inkjet 
paper (if Inkjet Paper is selected as 
paper group)

4.  Select any other desired print settings. 

5.  After you have selected the print settings, click OK.

printing envelopes with Mac OS X

1.  Open the Page Setup dialog box, then select the following settings: 

panel setting

Page Attributes 

Paper Size: Appropriate envelope size

Orientation: Appropriate envelope 
orientation

2.  Click OK. 

3.  Open the Print dialog box, then select the following settings: 

panel setting

Paper Type/Quality 
Paper Type: Automatic or Plain 
Paper

4.  Select any other desired print settings. 

5.  After you have selected the print settings, click Print.
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envelopes

For a description of available print options, click the appropriate operating 
system:
Mac OS 8.6, 9.x, or X Classic or Mac OS X.
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transparencies

transparencies

printing guidelines

For great results use hp premium inkjet transparency film.

preparing to print

1.  Raise the Out tray. 

2.  Slide out both paper guides, then remove all paper from the In tray. 

3.  Fan the edges of the transparency sheets to separate them, then align the edges. 

4.  Place up to 25 transparency sheets in the In tray with the rough side down and 
the adhesive strip toward the printer. 

 

5.  Carefully push the transparencies forward until they stop so that none of the 
adhesive strips catch on one another. 

6.  Slide the paper guides firmly against the transparency sheets. 

7.  Lower the Out tray. 

printing transparencies

●     My computer runs Mac OS 8.6 or 9.x 

●     I am using a Mac OS 9.x application on a Mac OS X 
computer

Mac OS 8.6, 9.x, and X 
Classic

I am using an application built for Mac OS X Mac OS X

printing transparencies with Mac OS 8.6, 9.x, and X Classic

1.  If necessary, open the Page Setup dialog box and select the page size, scaling, or 
orientation options. 

2.  Open the Print dialog box, then select the following settings: 
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transparencies

panel setting

Paper Type/Quality 

Paper Group: Automatic or 
Transparency Film

Paper Type: Appropriate 
transparency film (if Transparency 
Film is selected as paper group)

3.  Select any other desired print settings. 

4.  After you have selected the print settings, click OK. 

The printer may wait for transparencies to dry before releasing them to the top of 
the tray.

printing transparencies with Mac OS X

1.  If necessary, open the Page Setup dialog box and select the printer, page size, 
scaling, or orientation options. 

2.  Open the Print dialog box, then select the following settings: 

panel setting

Paper Type/Quality 
Paper Type: Automatic or the 
appropriate transparency film

3.  Select any other desired print settings. 

4.  After you have selected the print settings, click Print. 

The printer may wait for transparencies to dry before releasing them to the top of 
the tray.

For a description of available print options, click the appropriate operating 
system:
Mac OS 8.6, 9.x, or X Classic or Mac OS X.
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labels

labels

printing guidelines

●     Use only paper labels that are designed specifically for inkjet printers. 

●     Use only full sheets of labels. 

●     Verify that the labels are not sticky, wrinkled, or pulling away from the 
protective backing. 

●     Do not use plastic or clear labels. The ink will not dry on these labels. 

●     Never place more than 20 sheets of labels in the In tray at one time.

preparing to print

1.  Raise the Out tray.

2.  Slide out both paper guides, then remove all paper from the In tray.

3.  Fan the edges of the label sheets to separate them, then align the label edges.

4.  Load up to 20 label sheets—label side down—in the In tray.

5.  Slide the paper guides firmly against the sheets.

 

6.  Lower the Out tray.

printing labels

If your software program includes a label printing feature, follow the instructions 
provided with the software program. Otherwise, follow the instructions below. 

●     My computer runs Mac OS 8.6 or 9.x 

●     I am using a Mac OS 9.x application on a Mac OS X 
computer

Mac OS 8.6, 9.x, and X 
Classic
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labels

I am using an application built for Mac OS X Mac OS X

printing labels with Mac OS 8.6, 9.x, and X Classic

1.  Open the Page Setup dialog box, then select the following settings: 

panel setting

Page Attributes 
Page Size: A4 Letter or US Letter

Orientation: Appropriate orientation

2.  Click OK. 

3.  Open the Print dialog box, then select the following settings: 

panel setting

Paper Type/Quality 

Paper Group: Automatic, Plain 
Paper or Inkjet Paper

Paper Type: Appropriate inkjet 
paper (if Inkjet Paper is selected as 
paper group)

Quality: Normal

4.  Select any other desired print settings. 

5.  After you have selected the print settings, click OK.

printing labels with Mac OS X

1.  Open the Page Setup dialog box, then select the following settings: 

panel setting

Page Attributes 
Paper Size: A4 Letter or US Letter

Orientation: Appropriate orientation
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labels

2.  Click OK. 

3.  Open the Print dialog box, then select the following settings: 

panel setting

Paper Type/Quality 

Paper Type: Automatic or 
appropriate label type

Quality: Normal

4.  Select any other desired print settings. 

5.  After you have selected the print settings, click Print.

For a description of available print options, click the appropriate operating 
system:
Mac OS 8.6, 9.x, or X Classic or Mac OS X.
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index cards and other small media

index cards and other small media

printing guidelines

●     Use only cards and small media that meet the printer's paper size 
specifications. 

●     If an out of paper message appears, verify that the index cards or other small 
media are positioned properly in the In tray. 

●     To print borderless A6 (105 x 148.5 mm) cards, see borderless printing.

preparing to print index cards or other small media

1.  Remove the Out tray. 

 

2.  Slide out both paper guides, then remove all paper from the In tray. 

3.  Align the card edges. 

4.  Place up to 30 cards in the In tray. 

5.  Push the cards forward until they stop. 

6.  Slide the paper guides firmly against the edges of the cards. 

 

7.  Replace the Out tray. 
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index cards and other small media

 

printing index cards and other small media

If your software program includes a card printing feature, follow the instructions 
provided by the software program. Otherwise, follow the instructions below.

●     My computer runs Mac OS 8.6 or 9.x 

●     I am using a Mac OS 9.x application on a Mac OS X 
computer 

Mac OS 8.6, 9.x, and X 
Classic

I am using an application built for Mac OS X Mac OS X

printing index cards and other small media with Mac OS 8.6, 9.x, and X Classic

1.  Open the Page Setup dialog box, then select the following settings: 

panel setting

Page Attributes 
Page Size: Appropriate card size

Orientation: Appropriate orientation

2.  Click OK. 

3.  Open the Print dialog box, then select the following settings: 

panel setting
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index cards and other small media

Paper Type/Quality 

Paper Group: Automatic, Plain 
Paper or Inkjet Paper

Paper Type: Appropriate inkjet 
paper (if Inkjet Paper is selected as 
paper group)

Quality: Normal

Layout

Pages Per Sheet: 1 (Normal) 

Print Both Sides: Unchecked for 
unsupported card sizes

4.  Click OK. 

If an out of paper message appears, verify the cards are positioned properly in 
the paper tray.

printing index cards and other small media with Mac OS X

1.  Open the Page Setup dialog box, then select the following settings: 

panel setting

Page Attributes 
Paper Size: Appropriate card size

Orientation: Appropriate orientation

2.  Click OK. 

3.  Open the Print dialog box, then select the following settings: 

panel setting

Paper Type/Quality 

Paper Type: Automatic or Plain 
Paper

Quality: Normal

Layout Pages Per Sheet: 1 (Normal) 
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index cards and other small media

Two Sided Printing
Print Both Sides: Unchecked for 
unsupported card sizes 

4.  Select any other desired print settings. 

5.  After selecting the print settings, click Print. 

If an out of paper message appears, verify the cards are positioned properly in 
the paper tray.

For a description of available print options, click the appropriate operating 
system:
Mac OS 8.6, 9.x, or X Classic or Mac OS X.
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photographs

photographs

printing guidelines

●     The photo must be in an electronic format (digital) before it can be printed. 
Take a digital picture, scan a photo, or have your local camera shop provide an 
electronic file of the photo. 

●     For best print quality, install a photo print cartridge in the printer, use a High 
Resolution print setting, and set the HP Digital Photography options. 

●     To print borderless photos, see borderless printing. 

●     Use hp photo papers for great results.

preparing to print small photographs
For high-quality photos, install a photo print cartridge in the printer. For 
instructions on installing a print cartridge, see replacing print cartridges.

1.  Remove the Out tray. 

2.  Slide out both paper guides, then remove all paper from the In tray. 

3.  Fan the edges of the photo paper to separate them, then align the photo paper 
edges. 

4.  Place no more than 20 sheets of photo paper—printable side down—in the In tray. 

5.  Push the photo paper forward until it stops. 

6.  Slide the paper guides firmly against the edges of the photo paper. 

 

7.  Replace the Out tray.

preparing to print large photographs
For high-quality photos, install a photo print cartridge in the printer. For 
instructions on installing a print cartridge, see replacing print cartridges.
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photographs

1.  Raise the Out tray. 

2.  Slide out both paper guides, then remove all paper from the In tray. 

3.  Fan the edges of the photo paper to separate them, then align the photo paper 
edges. 

4.  Place no more than 20 sheets of photo paper—printable side down—in the In tray. 

5.  Slide the paper guides firmly against the edges of the photo paper. 

 

6.  Lower the Out tray.

printing photographs

●     My computer runs Mac OS 8.6 or 9.x 

●     I am using a Mac OS 9.x application on a Mac OS X 
computer

Mac OS 8.6, 9.x, and X 
Classic

I am using an application built for Mac OS X Mac OS X

printing photographs with Mac OS 8.6, 9.x, and X Classic

1.  Open the Page Setup dialog box, then select the following settings: 

panel setting

Page Attributes 

Page Size: Appropriate paper size

Orientation: Appropriate orientation

Borderless Printing:  Select if desired

2.  Click OK. 

3.  Open the Print dialog box, then select the following settings: 
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panel setting

Paper Type/Quality 

Paper Group: Automatic or 
Photo Paper

Paper Type: Appropriate hp photo 
paper type (if Photo Paper is 
selected as paper group)

Quality: Best or High Resolution 
Photo 

Digital Photography 
If desired for photo enhancement 
options (see digital photography)

4.  Select any other desired print settings. 

5.  After you have selected the print settings, click OK.

printing photographs with Mac OS X

1.  Open the Page Setup dialog box, then select the following settings: 

panel setting

Page Attributes 

Paper Size: Appropriate paper size

Orientation: Appropriate orientation

Borderless Printing: Select if desired

2.  Click OK. 

3.  Open the Print dialog box, then select the following settings: 

panel setting

file:///C|/Projects/Newport/Mac_UG_ROW/ug_photographs_fs.html (3 of 4) [5/9/2002 10:24:09 AM]

72



photographs

Paper Type/Quality 

Paper Type: Appropriate hp photo 
paper type

Quality: Best or High Resolution 
Photo 

Digital Photo: If desired for photo 
enhancement options (see digital 
photography)

4.  Select any other desired print settings. 

5.  After you have selected the print settings, click Print.

For a description of available print options, click the appropriate operating 
system:
Mac OS 8.6, 9.x, or X Classic or Mac OS X.

If a photo print cartridge is installed in the printer, replace it with a black print 
cartridge when you finish printing photographs. For instructions on storing the 
photo print cartridge when it is not in use, see maintaining print cartridges.
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greeting cards

greeting cards

printing guidelines

●     Unfold pre-folded cards, then place them in the In tray. 

●     If an out of paper message appears, verify that the cards are positioned 
properly in the In tray. 

●     For great results, use hp greeting card paper.

preparing to print

1.  Remove the Out tray. 

 

2.  Slide out both paper guides, then remove all paper from the In tray. 

3.  Fan the edges of the greeting cards to separate them. 

4.  Align the edges of the cards, then place no more than 5 cards in the In tray. 

 

5.  Push the cards forward until they stop. 

6.  Slide the paper guides firmly against the edges of the cards. 

7.  Replace the Out tray. 
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greeting cards

 

printing greeting cards

If your software program includes a greeting card printing feature, follow the 
instructions provided with the software program. Otherwise, follow the 
instructions below. 

●     My computer runs Mac OS 8.6 or 9.x 

●     I am using a Mac OS 9.x application on a Mac OS X 
computer 

Mac OS 8.6, 9.x, and X 
Classic

I am using an application built for Mac OS X Mac OS X

printing greeting with Mac OS 8.6, 9.x, and X Classic

1.  If necessary, open the Page Setup dialog box and select the page size, scaling, or 
orientation options. 

2.  Open the Print dialog box, then select the following settings: 

panel setting

Paper Type/Quality 

Paper Group: Automatic or 
Greeting Cards

Paper Type: Appropriate greeting 
card type (if Greeting Cards is 
selected as paper group)

Quality: Normal

Layout Pages Per Sheet: 1 (Normal)

3.  Click OK. 
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greeting cards

If an out of paper message appears, verify the greeting cards are 
positioned properly in the paper tray.

printing greeting cards with Mac OS X

1.  If necessary, open the Page Setup dialog box and select the printer, paper size, 
scaling, or orientation options. 

2.  Open the Print dialog box, then select the following settings: 

panel setting

Paper Type/Quality 

Paper Type: Automatic or Plain 
Paper

Quality: Normal

Layout Pages Per Sheet: 1 (Normal) 

3.  Select any other desired print settings. 

4.  After selecting the print settings, click Print. 

If an out of paper message appears, verify the greeting cards are positioned 
properly in the paper tray.

For a description of available print options, click the appropriate operating 
system:
Mac OS 8.6, 9.x, or X Classic or Mac OS X.
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posters

printing guidelines

Poster printing is not available in Mac OS X.

preparing to print

1.  Raise the Out tray. 

2.  Slide out both paper guides, then remove all paper from the In tray. 

3.  Fan the edges of the sheets to separate them, then align the edges. 

4.  Place the paper in the In tray. 

5.  Slide the paper guides firmly against the paper. 

 

6.  Lower the Out tray.

printing posters

1.  If necessary, open the Page Setup dialog box and set the page size, scaling, or 
orientation. 

2.  Open the Print dialog box, then select the following settings: 

panel setting

Paper Type/ Quality 

Paper Group: Automatic, Plain 
Paper or Inkjet Paper

Paper Type: Appropriate inkjet 
paper (if Inkjet Paper group is 
selected)

Print Quality: Normal 
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posters

Layout 
Multiple Page Per Sheet Menu: 
Tiling 

Tiling Size: 2, 3, or 4 

3.  Select any other desired print settings. 

4.  After you have selected the print settings, click OK. 

5.  After the poster has printed, trim the edges on the sheets then tape the sheets 
together. 

 

For a description of available print options, click Mac OS 8.6, 9.x, or X Classic.
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banners

banners

printing guidelines

Use hp banner paper for great results.

preparing to print

1.  Raise the Out tray. 

2.  Slide out both paper guides, then remove all paper from the In tray. 

3.  Select up to 20 sheets of banner paper. Remove and discard any perforated 
strips. 

4.  Place the banner paper in the In tray with the unattached edge of the paper 
facing the printer. 

 

1. unattached edge

5.  Slide the paper guides firmly against the paper. 

6.  Lower the Out tray.

printing banners

If your software program includes a banner printing feature, follow the 
instructions provided with the software program. Otherwise, follow the 
instructions below. 

●     My computer runs Mac OS 8.6 or 9.x 

●     I am using a Mac OS 9.x application on a Mac OS X 
computer 

Mac OS 8.6, 9.x, and X 
Classic
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banners

I am using an application built for Mac OS X Mac OS X

printing banners with Mac OS 8.6, 9.x, and X Classic

1.  Open the Page Setup dialog box, then select the following settings: 

panel setting

Page Attributes Page Size: A4 Letter Banner or US 
Letter Banner

2.  Click OK. 

3.  Open the Print dialog box, then select the following settings: 

panel setting

Paper Type/Quality 

Paper Group: Automatic, Plain 
Paper or Inkjet Paper

Paper Type: Appropriate inkjet 
paper (if Inkjet Paper group is 
selected)

Quality: Normal

4.  Click OK. 

printing banners with Mac OS X

1.  Open the Page Setup dialog box, then select the following settings: 

panel setting

Page Attributes Paper Size: A4 Letter Banner or US 
Letter Banner

2.  Click OK. 
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3.  Open the Print dialog box, then select the following settings: 

panel setting

Paper Type/Quality 

Paper Type: Automatic or Plain 
Paper

Quality: Normal

4.  Select any other desired print settings. 

5.  After selecting the print settings, click Print.

For a description of available print options, click the appropriate operating 
system:
Mac OS 8.6, 9.x, or X Classic or Mac OS X.
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iron-on transfers

iron-on transfers

printing guidelines

●     When printing a document with a mirror-image, the text and pictures are 
horizontally reversed from what appears on the computer screen. 

 

●     Use hp iron-on t-shirt transfer paper for great results.

preparing to print

1.  Raise the Out tray. 

2.  Slide out both paper guides, then remove all paper from the In tray. 

3.  Fan the edges of the iron-on transfer paper to separate them, then align the 
edges. 

 

4.  Place the iron-on transfer paper in the In tray with the printable side down. 

5.  Slide the paper guides firmly against the transfer paper. 

6.  Lower the Out tray.

printing iron-on transfers

If your software program includes an iron-on transfer printing feature, follow the 
instructions provided with the software program. Otherwise, follow the 
instructions below. 

file:///C|/Projects/Newport/Mac_UG_ROW/ug_iron-on_transfers_fs.html (1 of 3) [5/9/2002 10:24:11 AM]

82



iron-on transfers

●     My computer runs Mac OS 8.6 or 9.x 

●     I am using a Mac OS 9.x application on a Mac OS X 
computer 

Mac OS 8.6, 9.x, and X 
Classic

I am using an application built for Mac OS X Mac OS X

printing iron-on transfers with Mac OS 8.6, 9.x, and X Classic

1.  Open the Page Setup dialog box, then select the following settings: 

panel setting

Page Attributes 
Page Size: A4 Letter  or US Letter

Mirror Image: Checked

2.  Click OK. 

3.  Open the Print dialog box, then select the following settings: 

panel setting

Paper Type/Quality 

Paper Group: Automatic or Plain 
Paper

Quality: Normal

4.  Click OK. 

printing iron-on transfers with Mac OS X

The Mirror Image feature is not available in Mac OS X.  Some applications offer 
a mirror image feature that will allow you to print iron-on transfers from a Mac 
OS X computer. 

1.  Open the Page Setup dialog box, then select the following settings: 
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iron-on transfers

panel setting

Page Attributes 
Page Size: A4 Letter or US Letter

Orientation: Appropriate orientation

2.  Click OK. 

3.  Open the Print dialog box, then select the following settings: 

4.  

panel setting

Paper Type/Quality 

Paper Type: Automatic or Plain 
Paper

Quality: Normal

5.  Select any other desired print settings. 

6.  After selecting the print settings, click Print.

For a description of available print options, click the appropriate operating 
system:
Mac OS 8.6, 9.x, or X Classic or Mac OS X.
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maintenance

●     replacing print cartridges 

●     aligning print cartridges 

●     automatically cleaning print cartridges 

●     cleaning the print cartridge cradle 

●     maintaining print cartridges 

●     maintaining the printer body 

●     refilling print cartridges 

●     removing ink from skin and clothing 

●     using the hp inkjet utility
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replacing print cartridges

replacing print cartridges

Before buying replacement print cartridges, verify the correct part numbers. For the 
correct part numbers, see print cartridges.

The printer can operate with only one print cartridge installed. For more 
information, see reserve mode. 

To replace a print cartridge:

1.  Press the Power button to turn on the printer. 

2.  Open the top cover. 

The cradle moves to the center of the printer.

3.  Open the cradle latch. 

4.  Slide the print cartridge out of the print cartridge cradle and discard it. 

1. press Power button 2. open top cover
3. open cradle latch 4. slide print cartridge out of cradle 

5.  Remove the replacement print cartridge from its packaging and carefully remove 
the plastic tape. Hold the print cartridge so that the copper strip is on the bottom. 
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replacing print cartridges

 

1. pink pull tab

Caution! Do not touch the print cartridge ink nozzles or copper contacts. Touching these 
parts will result in clogs, ink failure, and bad electrical connections. Do not remove the 
copper strips. They are required electrical contacts.

6.  Slide the print cartridge firmly into the cradle as shown. 

Ensure that the copper contacts of the print cartridge meet the copper contacts of 
the print cartridge cradle.

 

1. copper contacts 

7.  Close the cradle latch. Pull the latch forward, then press it down to tuck the tabs 
into place. 

8.  Close the top cover.

If the Print Cartridge Status light continues to blink after installing a new print 
cartridge, verify the part number on the cartridge.

9.  Open the hp inkjet utility to print a test page.  For instructions on using the hp 
inkjet utility, see hp inkjet utility.

After you change the print cartridge, the printer is automatically calibrated for optimum 
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replacing print cartridges

print quality.

For information on how to recycle your empty print cartridge, see print cartridge 
recovery.

Warning! Keep both new and used print cartridges out of the reach of children.
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refilling print cartridges 

refilling print cartridges 

 

To get the best performance from your HP printer, use only genuine, factory-
filled HP print cartridges. 

Caution! Damage that is directly attributable to modified or refilled HP print cartridges is 
specifically excluded from the HP printer’s warranty coverage. 
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aligning print cartridges

aligning print cartridges

After a print cartridge is replaced, align the print cartridges to ensure the best print 
quality. Alignment is performed from the hp inkjet utility. 

1.  Open the  hp inkjet utility. 

2.  Select the Calibrate  panel. 

3.  Click the Align button then follow the onscreen directions.
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automatically cleaning print cartridges

If your printed pages are missing lines or dots or if streaks appear, the print cartridges 
need to be cleaned.

Print cartridges are cleaned automatically using the following procedure:

1.  Open the hp inkjet utility. 

2.  Select the Clean panel. 

3.  Click the Clean button, then follow the onscreen instructions. 

If your printouts are still missing lines or dots after cleaning, a print cartridge may be 
low on ink. One or both print cartridges may need to be replaced.

If a print cartridge is low on ink and you do not have a replacement cartridge 
available, use the printer in reserve mode.
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cleaning the print cartridge cradle

cleaning the print cartridge cradle

If the printer is used in a dusty environment, a small amount of debris may accumulate 
inside the case. This debris can include dust, hair, carpet, or clothing fibers. When it 
gets on the print cartridge cradle, it can cause smudges on printed pages. Smudges are 
easily corrected by cleaning the print cartridge cradle.

gathering cleaning supplies

You will need the following items to clean the print cartridge cradle:

●     Distilled water. Tap water contains contaminants that damage the cradle.

●     Cotton swabs or other soft, lint-free material that will not stick to the cradle.

Caution! Be careful not to get ink on your hands or clothing as you clean.

preparing to clean

1.  Press the Power button to turn on the printer, then raise the top cover.

The print cartridges move to the center of the printer.

2.  Disconnect the power cord from the back of the printer.

3.  Remove the print cartridges and place them on a piece of paper with the copper 
contacts facing up.

Do not leave the cartridges outside the printer for more than 30 minutes.

Caution! Do not touch the print cartridge ink nozzles or copper contacts. Touching these 
parts will result in clogs, ink failure, and bad electrical connections. Do not remove the 
copper strips. They are required electrical contacts.

cleaning the print cartridge cradle

1.  Lightly moisten a cotton swab with distilled water.

2.  Wipe the underside of the print cartridge cradle walls using the swab.

file:///C|/Projects/Newport/Mac_UG_ROW/ug_cleaning_the_print_cartridge_cradle_fs.html (1 of 2) [5/9/2002 10:24:14 AM]

92



cleaning the print cartridge cradle

1. print cartridge cradle 2. print cartridge cradle walls

3.  Repeat this process until no ink residue appears on a clean swab.

4.  Reinsert the print cartridges and close the printer's top cover.

5.  Reconnect the power cord to the back of the printer.
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maintaining print cartridges

maintaining print cartridges

The following tips will help maintain HP print cartridges and ensure consistent print 
quality:

●     Keep all print cartridges in their sealed packages until they are needed. Print 
cartridges should be stored at room temperature (60–78 degrees F or 
15.6–26.6 degrees C).

●     Do not remove the protective tape covering the ink nozzles until you are ready 
to install the print cartridge in the printer. If the plastic tape has been removed 
from the print cartridge, do not attempt to reattach it. Reattaching the tape 
damages the print cartridge.

storing print cartridges

When print cartridges are removed from either their sealed containers or the printer, 
store them in a print cartridge protector or an airtight plastic container.

A print cartridge protector comes with the photo print cartridge. If you store the print 
cartridge in an airtight plastic container make sure that the ink nozzles face down.

inserting the print cartridge into the print cartridge protector 

Slide the print cartridge at an angle into the protector, and snap it securely in place.

 

removing the print cartridge from the print cartridge protector 

Press down and back on the top of the protector to release the cartridge. Slide the 
cartridge out of the protector.
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maintaining print cartridges

 

Caution! Do not drop the print cartridge. Dropping the print cartridge may result in damage to 
the print cartridge. 
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maintaining the printer body

maintaining the printer body

Because the printer ejects ink onto the paper in a fine mist, ink smudges will eventually 
appear on the printer case and adjacent surfaces. To remove smudges, stains, and/or 
dried ink from the exterior of the printer, use a soft cloth moistened with water.

When cleaning your printer, keep these tips in mind:

●     Do not clean the interior of the printer. Keep all fluids away from the interior.

●     Do not use household cleaners or detergent. In the event that a household 
cleaner or detergent is used on the printer, wipe the printer's exterior surfaces 
with a soft cloth moistened with water.

●     Do not lubricate the support rod that the print cartridge cradles use to slide 
back and forth. Noise is normal when the cradles move back and forth.
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removing ink from skin and clothing 

removing ink from skin and clothing 

Follow these steps to remove ink from skin and clothing: 

to remove ink from... do this... 

skin Wash the affected area with an abrasive soap. 

white fabric Wash the fabric in cold water using chlorine bleach. 

color fabric Wash the fabric in cold water using sudsy ammonia. 

Caution! Always use cold water to remove ink from fabric. Warm or hot water may set the ink 
color into the fabric. 
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hp inkjet utility 

using the hp inkjet utility

The hp inkjet utility contains tools to calibrate the printer, clean the print cartridges, print a test page, 
and find Website support information.

Select the appropriate option:

My computer runs Mac OS 8.6 or 9.x Mac OS 8.6 and 9.x

My computer runs Mac OS X Mac OS X

Mac OS 8.6 and 9.x

displaying the hp inkjet utility

1.  Double-click the Macintosh HD icon on the desktop. 

2.  Do one of the following: 

❍     Mac OS 8.6 to Mac OS 9.0: Select Utilities, then double-click hp 

❍     Mac OS 9.1: Select Applications (Mac OS 9), double-click Utilities, then double-click 
hp 

3.  Double-click hp inkjet utility.

hp inkjet utility panels

The following options are available on the hp inkjet utility:
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hp inkjet utility 

 

1.  Inkjet Utility Panel Menu: Select the appropriate panel: 

❍     WOW!: Prints a sample page to view the output quality of the printer. 

❍     Test: Prints a test page to confirm communication with printer. 

❍     Clean: Cleans the print cartridges. 

❍     Calibrate: Aligns the print cartridges. 

❍     Configure: Enables Auto-Off feature. 

❍     Support: Provides access to the HP Website where you can find support for the printer 
and information about HP products and supplies. 

❍     Register: Accesses the HP Website to register the printer.

Mac OS X

displaying the hp inkjet utility

1.  Double-click the OS X HD icon on the desktop. 
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hp inkjet utility 

2.  Select Applications, then double-click Utilities. 

3.  Select hp inkjet utility.

viewing the hp inkjet utility panels

The following options are available on the hp inkjet utility:

 

1.  Inkjet Utility Panel Menu: Select the appropriate panel: 

❍     WOW!: Prints a sample page to view the output quality of the printer. 

❍     Test: Prints a test page or a diagnostic page. 

❍     Clean: Cleans the print cartridges. 

❍     Calibrate: Aligns the print cartridges. 

❍     Configure: Enables Auto-Off feature. 

❍     Support: Provides access to the HP Website where you can find support for the printer 
and information about HP products and supplies. 

❍     Register: Accesses the HP Website to register the printer.
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troubleshooting 

troubleshooting 

Click the topic below that best describes the problem: 

●     printer is not printing 

●     problems with printouts 

●     printer lights are flashing or on 

●     printer is too slow 

●     borderless printing problems 

If you continue to have problems after investigating the above topics, contact HP 
Customer Care. 
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printer is not printing

printer is not printing

verify the following 

●     The printer is connected to the power source. 

●     The cable connections are secure. 

●     The printer is turned on. 

●     The media is correctly placed in the paper tray. 

●     The printer's top cover is closed. 

●     The Automatic Two-Sided Printing Accessory or Rear Access Door is attached. 

●     The print cartridges are correctly installed.

check the printer lights 

●     If the Power light is blinking, the printer is in the process of printing. 

●     If the Resume light is blinking, press the Resume button. 

●     If the Print Cartridge Status light is blinking, see print cartridge status light 
is flashing. 

●     If the Print Cartridge Status light is on, see print cartridge status light is on.

select a topic below 

If the printer still does not print, select the topic below that best describes the problem:

●     printer makes a loud noise after a print cartridge is installed 

●     paper problems 

●     USB problems 

●     printer does not turn on 

●     printer driver not found in OS X Classic 

printer makes a loud noise after a print cartridge is installed

If the print cartridge is installed backwards, the printer makes a loud noise. 

1.  Open the top cover. 

2.  Remove the print cartridge, then reinsert it as shown. Ensure that the copper 
contacts of the print cartridge meet the copper contacts of the print cartridge 
cradle. 

file:///C|/Projects/Newport/Mac_UG_ROW/ug_notprinting_fs.html (1 of 4) [5/9/2002 10:24:17 AM]

102



printer is not printing

 

1. Copper contacts

Caution! Do not touch the print cartridge ink nozzles or copper contacts. Touching these 
parts will result in clogs, ink failure, and bad electrical connections. Do not remove the 
copper strips. They are required electrical contacts.

3.  Close the top cover. 

4.  Press the Resume button. 

Wait until the Power light stops flashing before printing a file.

paper problems

Click the topic below that best describes the problem:

●     paper jam 

●     out of paper 

●     printer ejects the paper 

paper jam

Follow each of these steps until the paper jam is cleared.

1.  Remove the paper from the In and Out trays. 

2.  Press the Resume button. 

3.  If you are printing labels, verify that a label did not become detached from the 
label sheet while passing through the printer. 
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printer is not printing

If the paper jam is not cleared after performing these steps: 

1.  Open the Rear Access Door by turning the latch counter-clockwise and removing 
the door. 

 

2.  Remove the paper jam, then replace the Rear Access Door. 

 

3.  Reload paper into the In tray. 

4.  Press the Resume button. 

5.  Print the document. 

out of paper

if the paper tray is loaded 

1.  Adjust the length guide so that the paper stack touches the back of the paper 
tray. 

2.  Slide the paper forward until it stops. 
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printer is not printing

3.  Press the Resume button.

if the paper tray is empty 

1.  Load paper in the tray. 

2.  Press the Resume button.

printer ejects the paper

●     Move the printer away from direct sunlight. The printer may have been placed 
in direct sunlight which can affect the Automatic Paper-Type Sensor. 

—or—

●     Select a paper type other than Automatic.

USB problems

there are conflicting USB cable connections

A printing conflict may arise when the printer and several USB devices are attached to a 
hub. There are two methods for solving the conflict:

●     Attach the printer's USB cable directly to the computer. 

—or—

●     If the printer is attached to a hub, do not use other USB devices attached to 
the hub while printing.

printer does not turn on

The printer may have drawn too much power.

1.  Disconnect the power cord from the printer. 

2.  Wait approximately 10 seconds. 

3.  Reconnect the power cord to the printer. 

4.  Press the Power button to turn on the printer. 

printer driver not found in Mac OS X Classic

The printer driver you need may have to be installed separately.  If no hp inkjet printer 
icon appears in the Chooser, load the driver from the CD for Mac OS X Classic.
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problems with printouts

problems with printouts

Click the topic below that best describes the problem:

●     print quality is poor 

●     text and images are misaligned 

●     document is printed off-center or at an angle 

●     parts of the document are missing or printed in the wrong place 

●     printout does not reflect new print settings 

●     photos are not printing correctly 

●     banner does not print correctly 

●     blank pages print

print quality is poor

●     print cartridges need to be cleaned 

●     print is faded 

●     too much or too little ink appears on the page

print cartridges need to be cleaned

If your printed pages are missing lines or dots or if streaks appear, the print cartridges 
need to be cleaned.

For cleaning instructions, see automatically cleaning print cartridges.

print is faded

1.  Verify that a black print cartridge is installed. If the black text and images on your 
printouts are faded, you may be printing using only the tri-color print cartridge. 
Insert a black print cartridge, in addition to the tri-color print cartridge, for true 
black print resolution. 

2.  Verify that neither of the print cartridges is low on ink. If a print cartridge is low 
on ink, consider replacing the print cartridge. 

If you do not have a replacement cartridge, remove the low-ink cartridge 
and use the printer in the reserve mode.

3.  Verify that the plastic tape has been removed from both print cartridges. 
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problems with printouts

too much or too little ink appears on the page

In the Page Setup dialog box, select a paper type other than Automatic.

1.  Open the Print dialog box. 

2.  Select the Paper Type/Quality panel then do one of the following: 

❍     Mac OS 8.6, 9.x, or Classic: Select a Paper Group other than 
Automatic, then select a paper type if necessary. 

❍     Mac OS X: Select an appropriate paper type other than Automatic.

3.  Reprint the document. 

text and images are misaligned

If the text and images on your printouts are misaligned, then calibrate the printer to 
align the print cartridges.

Follow these steps to calibrate the printer:

1.  Open the hp inkjet utility. 

2.  Select the Calibrate  panel. 

3.  Click the Align button, then follow the onscreen instructions. 

document is printed off-center or at an angle

1.  Verify that the paper is correctly placed in the paper tray. 

2.  Verify that the paper guides fit firmly against the paper. 

3.  Reprint the document. 

parts of the document are missing or printed in the wrong place

1.  Open the Page Setup dialog box and verify the following:

panel setting
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problems with printouts

Page Attributes 

Page Size or Paper Size: Appropriate 
paper size

Scale: Select to scale text and graphics 
to fit on the paper

Orientation: Appropriate orientation

2.  If you are using Mac OS 8.6, 9.x, or X Classic, open the Print dialog box and 
verify the following:

panel setting

Layout 

Tiling: If you see this option and you are not 
printing a poster, select Multiple Pages Per 
Sheet, then select 1 (Normal) in the Pages Per 
Sheet box.

printout does not reflect new print settings

The printer's default settings may differ from the software application's print settings. 
Select the appropriate print settings within the software application.

photos are not printing correctly

check the paper tray

1.  Verify that the photo media is placed in the paper tray with the print side down. 

2.  Slide the paper forward until it stops. 

3.  Slide the paper guides firmly against the paper, then push in the tray. 

check the printer settings 

1.  Open the Page Setup dialog box and verify the following setting: 

panel setting

Page Attributes Page Size or Paper Size: Appropriate 
paper size 
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problems with printouts

2.  Open the Print dialog box and verify the following: 

panel setting

Paper Type/Quality 

Paper Group: Photo Paper (Mac 
OS 8.6. 9.x, and X Classic only)

Paper Type: An hp photo paper

Quality: Best or High Resolution 
Photo

banner does not print correctly

check the paper tray

1.  Unfold and refold the paper when several sheets feed into the printer at once. 

2.  Confirm that the unattached edge of the banner paper stack is on top of the paper 
stack and facing the printer. 

3.  Verify that the correct paper for banner printing is used. 

check the printer settings 

Open the Page Setup dialog box and verify the following setting:

panel setting

Page Attributes Page Size or Paper Size: Select A4 Letter 
Banner or US Letter Banner 

check the software

●     Verify that the software application you are using prints banners. Not all 
software applications print banners. 

●     If gaps appear at the ends of the sheets, verify that the printer software is 
operating correctly.

blank pages print
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problems with printouts

●     The protective piece of plastic tape may still be attached to the print 
cartridges. Verify that the plastic tape has been removed from the print 
cartridges. 

●     The print cartridges may be out of ink. Replace one or both empty print 
cartridges. 

●     The printer may be in direct sunlight. Direct sunlight can adversely affect the 
Automatic Paper-Type Sensor. Move the printer out of direct sunlight. 
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printer lights are flashing or on

printer lights are flashing or on

●     what the lights indicate 

●     Print Cartridge Status light is on 

●     Print Cartridge Status light is flashing 

●     Resume light is flashing 

●     Power light is flashing 

●     all lights are flashing 

what the lights indicate

Flashing or on lights indicate the printer status.

 

1. Print Cartridge Status light 2. Resume light 3. Power light

Resume light is flashing

the printer may be out of paper

1.  Place paper in the In tray.

2.  Press the Resume button on the front of the printer.

there may be a paper jam

Follow these instructions to clear a paper jam.
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printer lights are flashing or on

the printer may be ready to print the second side of a two-sided document

1.  Follow the onscreen instructions for printing the second side.

These instructions appear when you manually print a two-sided document.

2.  Press the Resume button.

Power light is flashing

the printer is preparing to print

The light stops flashing when the printer has received all data.

all lights are flashing

the printer may need to be restarted

1.  Press the Power button to turn off the printer, then press the Power button to 
restart the printer.

Proceed to step 2 if the lights continue to flash.

2.  Press the Power button to turn off the printer.

3.  Disconnect the printer from the power source.

4.  Reconnect the printer to the power source.

5.  Press the Power button to turn on the printer.
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print cartridge status light is on

print cartridge status light is on

The Print Cartridge Status light is on when one or both of the cartridges is low on ink.

1. Print Cartridge Status light

1.  Open the printer's top cover. 

2.  Note the print cartridge cradle's position. Click the appropriate description below:

●     Print cartridge cradle is on the left 

●     Print cartridge cradle is on the right 

●     Print cartridge cradle is in the center 

print cartridge cradle is on the left

black or photo print cartridge is low on ink

At some point, print quality will deteriorate. We recommend that you have a 
replacement print cartridge available.

If you do not have a replacement available, you may remove the black or the photo 
print cartridge and print in reserve mode using only the tri-color print cartridge.

The printer may print more slowly and colors may be altered when using only the tri-
color print cartridge.

print cartridge cradle is on the right

tri-color print cartridge is low on ink

At some point, print quality will deteriorate. We recommend that you have a 
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print cartridge status light is on

replacement print cartridge available. 

If you do not have a replacement available, you may remove the tri-color print cartridge 
and print in reserve mode using only the black or photo print cartridge. 

The printer prints all documents in grayscale when using only the black or photo print 
cartridge.

print cartridge cradle is in the center

both print cartridges are low on ink

At some point, print quality will deteriorate. We recommend that you have replacement 
print cartridges available. 
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print cartridge status light is flashing 

print cartridge status light is flashing

The Print Cartridge Status light flashes when one or both of the print cartridges is 
improperly installed or malfunctioning.

 

1. Print Cartridge Status light

1.  Open the printer's top cover.

2.  Note the print cartridge cradle's position. Click the appropriate description below: 

●     Print cartridge cradle is on the left 

●     Print cartridge cradle is on the right 

●     Print cartridge cradle is in the center 

the print cartridge cradle is on the left

there is a problem with the black or photo print cartridge
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print cartridge status light is flashing 

 

1. the print cartridge cradle on the left indicates a problem with black or photo print 
cartridge

To solve the problem:

1.  Remove the print cartridge.

2.  Re-insert the print cartridge.

If the problem persists, replace the black or photo print cartridge.

the print cartridge cradle is on the right

there is a problem with the tri-color print cartridge

 

1. the print cartridge cradle on the right indicates a  problem with tri-color print 
cartridge
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print cartridge status light is flashing 

To solve the problem:

1.  Remove the print cartridge.

2.  Re-insert the print cartridge. 

If the problem persists, replace the tri-color print cartridge.

print cartridge cradle is in the center and the print cartridge status light is 
flashing

If the print cartridge carriage is in the center with a blinking Print Cartridge Status light, 
the printer cannot yet diagnose the problem.

To determine the print cartridge problem, do the following:

1.  Remove the print cartridge on the right side of the cradle.

2.  Close the cover.

3.  Wait until the printer is silent, then re-open the cover.

4.  Note the position of the print cartridge cradle and the behavior of the Print 
Cartridge Status light. Click the appropriate description below:

●     Print cartridge cradle is on the right and the status light is on 

●     Print cartridge cradle is on the right and the status light is flashing 

●     Print cartridge cradle is still in the center

print cartridge cradle is still in the center

there is a problem with the black or photo print cartridge

To solve the problem:

1.  Remove the print cartridge.

2.  Re-insert the print cartridge. 

If the problem persists, replace the black or photo print cartridge.

print cartridge cradle is on the right and the status light is on

●     there is a problem with the black or photo print cartridge

To solve the problem:

1.  Remove the print cartridge.

2.  Re-insert the print cartridge. 
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print cartridge status light is flashing 

If the problem persists, replace the black or photo print cartridge.

-and-

●     the tri-color print cartridge is low on ink

At some point, print quality will deteriorate. We recommend that you have a 
replacement print cartridge available. 

If you do not have a replacement available, you may remove the tri-color print 
cartridge and print in reserve mode using only the black or photo print cartridge.

The printer prints all documents in grayscale when using only the black print 
cartridge.

print cartridge cradle is on the right and the status light is flashing

To solve the problem:

1.  Remove the print cartridge on the left side of the cradle.

2.  Reinsert the right print cartridge on the right side of the cradle.

3.  Close the cover.

4.  Wait until the printer is silent, then re-open the cover.

5.  Note the position of the print cartridge cradle and the behavior of the Print 
Cartridge Status light. Click the appropriate description below:

●     Print cartridge cradle is on the left and the status light is flashing 

●     Print cartridge cradle is on the left and the status light is on 

●     Print cartridge cradle is in the center 

print cartridge cradle is in the center

there is a problem with the tri-color print cartridge

To solve the problem:

1.  Remove the print cartridge.

2.  Re-insert the print cartridge. 

If the problem persists, replace the tri-color print cartridge.

print cartridge cradle is on the left and the status light is flashing

there is a problem with both the black or photo print cartridge and the tri-color 
print cartridge
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print cartridge status light is flashing 

To solve the problem:

1.  Remove the remaining print cartridge.

2.  Re-insert the print cartridges. 

If the problem persists, replace the black or photo print cartridge(s).

print cartridge cradle is on the left and the status light is on

●     there is a problem with the tri-color print cartridge

To solve the problem:

1.  Remove the print cartridge.

2.  Re-insert the print cartridge. 

If the problem persists, replace the tri-color print cartridge.

-and-

●     the black or photo print cartridge is low on ink

At some point, print quality will deteriorate. We recommend that you have a 
replacement print cartridge available. 

If you do not have a replacement available, you may remove the black print 
cartridge and print in reserve mode using only the tri-color print cartridge.

The printer may print more slowly and colors may be altered when using only the 
tri-color print cartridge.
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printer is slow

printer is slow

Several variables can slow the printer's performance. Click the topic below that best 
describes the printer's performance:

●     multiple software applications are open 

●     complex documents, graphics, or photographs are printing 

●     automatic paper type option is enabled 

●     two-sided documents are printing 

If none of the above topics describes the printer's performance, then review the 
following:

●     printer driver is outdated 

●     computer does not meet system requirements 

●     printer is in reserve mode 

multiple software applications are open

If too many software applications are open, the printer cannot print at its optimum 
speed.

Close all unnecessary software applications, then print the document again.

complex documents, graphics, or photographs are printing

Documents containing graphics or photographs print slower than text documents. 

automatic paper type option is enabled

When the Automatic paper type option is enabled, it takes a few seconds for the printer 
to scan the first page of the print job to determine the appropriate paper type.

To increase the print speed, turn off the Automatic Paper-Type Sensor.

For instructions on turning off the Automatic Paper-Type Sensor, see using the 
automatic paper-type sensor.

two-sided documents are printing

Printing two-sided documents takes longer than printing single-sided documents.

printer driver is outdated

An outdated printer driver may be installed.

Log onto HP's Website at http://www.hp.com/go/support .
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printer is slow

computer does not meet system requirements

Verify that the computer's hard disk space, RAM, and processor speed meet system 
requirements. 

For more information, see system requirements.

printer is in reserve mode

The printer may print more slowly if it is in reserve mode.

Order a replacement print cartridge.
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borderless printing problems

borderless printing problems

image is printed at angle

if your printout looks like this... 

 

do this... 

1.  Load the paper correctly in the In tray. 

2.  Verify that the paper guides fit firmly against the cards or photo paper. 

3.  Follow loading instructions for the paper type. See borderless printing.

border is on top of image

if your printout looks like this... 

 

do this... 

Calibrate the printer.
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borderless printing problems

border is on side of image

if your printout looks like this... 

 

do this... 

Calibrate the printer.

image is above tear-off tab

if your printout looks like this... 

 

do this... 

Calibrate the printer.

ink smears

if your printout has ink smears... 

If ink smears appear on the back of the printouts or if the paper sticks together...

do this... 
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borderless printing problems

1.  Open the Print dialog box. 

2.  Select the Paper Type/Quality panel. 

❍     Mac OS 8.6, 9.x, or X Classic: Click the Ink tab. 

❍     Mac OS X: Click the Options tab.

3.  Adjust the dry time. 

4.  After adjusting the dry time, click one of the following: 

❍     Mac OS 8.6, 9.X, or X Classic: OK 

❍     Mac OS X: Print 

If the problem persists: 

1.  Remove the borderless printing media, then load plain letter or A4 paper in the In 
tray. 

2.  Press and hold down the Resume button until the printer starts printing a self-
test page, then release the Resume button. 

3.  Repeat step 2 until the self-test page has no ink smears on the back of the paper.
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"There is a problem with the print cartridges" error message appears on the computer screen 

"There is a problem with the print cartridges" error message 
appears on the computer screen

1.  Open the printer's top cover to activate the Print Cartridge Status light.

1. Print Cartridge Status light

2.  Note the Print Cartridge Status light. Click the appropriate description below:

●     Print Cartridge Status light is on 

●     Print Cartridge Status light is flashing 
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specifications 

specifications 

●     printer specifications 

●     minimum printing margins 

●     minimum system requirements 

●     environmental statement 

●     print cartridge recovery 

●     limited warranty 

●     regulatory notices 
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printer specifications 

hp deskjet 5550 series 

black text print speed *

FastDraft: Up to 17 pages per minute

Everyday: Up to 8 pages per minute

Normal: Up to 6 pages per minute

Inkjet Paper/Best or High Resolution Photo (1200 dpi text rendering): Up to 2 pages per 
minute

mixed text with color graphics print speed*

FastDraft: Up to 12 pages per minute

Everyday: Up to 6 pages per minute

Normal: Up to 4 pages per minute

Inkjet Paper/Best or High Resolution Photo (1200 dpi text rendering): Up to 0.5 page 
per minute

*These are approximate figures. Exact speed varies with system configuration, software 
program, and document complexity.

black TrueType™ text resolution (depending on paper type)

Plain Paper/FastDraft: 300 x 300 dpi

Plain Paper/Everyday: 300 x 300 dpi

Plain Paper/Normal: 600 x 600 dpi

Plain Paper/Best: 600 x 600 dpi

Inkjet Paper/High Resolution Photo (1200 dpi text rendering): 1200 x 1200 dpi

color input resolution (depending on paper type)

Plain Paper/FastDraft: 300 x 300 dpi

Plain Paper/Everyday: 300 x 300 dpi

Plain Paper/Normal: 600 x 600 dpi

Plain Paper/Best: 600 x 600 dpi
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Inkjet Paper/High Resolution Photo (1200 dpi text rendering): 1200 x 1200 dpi

color printing resolution (subject to color input resolution above)

Plain Paper/FastDraft: 600 x 300 dpi

Plain Paper/Everyday: 600 x 600 dpi

Plain Paper/Normal: 600 x 600 dpi

Plain Paper/Best: 600 x 600 dpi

Inkjet Paper/High Resolution Photo (1200 dpi text rendering): 1200 x 1200 dpi

4800 x 1200 optimized dpi resolution

4800 x 1200 optimized dpi color printing on premium photo papers, High Resolution 
Photo, 1200 x 1200 input dpi; may require a large amount of disk space depending on 
input image and will take longer to print, depending on input image.

color and photo print cartridges

Up to 6 ink printing

(Requires hp photo print cartridge #58) 

For more information, see print cartridges.

print technology

Drop-on-demand thermal inkjet printing

software compatibility

USB connection: Mac OS version 8.6, 9.x, or Mac OS X (version 10.1.x)

AppleTalk connection: Mac OS version 8.6, 9.x, or Mac OS X (version 10.1.x)

duty cycle

3000 pages per month

memory
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8 MB built-in RAM

processor

96 MHz processor

buttons and lights

Cancel button

Print Cartridge Status light

Resume button and light

Power button and light

i/o interface

Centronics Parallel, IEEE 1284–Compliant with 1284-B receptacle

Universal Serial Bus (USB) 2.0 compatible

dimensions

Without Automatic Two-Sided Printing Module:

449 mm wide x 144 mm high x 368 mm deep

operating environment

Maximum operating conditions:

Temperature: 41 to 104 degrees F, 5 to 40 degrees C

Humidity: 15 to 80 percent RH non-condensing

Recommended operating conditions for best print quality:

Temperature: 59 to 95 degrees F or 15 to 35 degrees C

Humidity: 20 to 80 percent RH non-condensing

Storage conditions:

Temperature: -40 to 158 degrees F, -40 to 70 degrees C
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power consumption

2 watts maximum when off

4 watts average non-printing

30 watts average when printing

power requirements

For power adapter part number 0950-4082 the power requirements are:

Input Voltage: 100 to 240 Vac (± 10%)

Input Frequency: 50 - 60 Hz

declared noise emissions in accordance with ISO 9296

Best Mode:

Sound power level, LWAd without Automatic Two-Sided Printing Module: 5.3 Bels (A) 
[53 dB (A)]

Sound pressure level, LpAm (bystander positions) without Automatic Two-Sided Printing 
Module: 40 dB (A)

Normal Mode:

Sound power level, LWAd without Automatic Two-Sided Printing Module: 5.9 Bels(A) [59 
dB (A)]

Sound pressure level, LpAm (bystander positions) without Automatic Two-Sided Printing 
Module: 47 dB (A)

alignment

Skew:

± .006 mm/mm (.006 in/in) on plain paper and cards

± .010 mm/mm (.010 in/in) on HP transparency films

media weight

Paper:

U.S. Letter 60 to 90 g/m ² (16 to 24 lb)

Legal 75 to 90 g/m ² (20 to 24 lb)
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Envelopes: 75 to 90 g/m ² (20 to 24 lb)

Cards: Up to 200 g/m ² (110 lb index max)

Banner paper: 60 to 90 g/m ² (16 to 24 lb)

media handling

In tray capacity: 

Plain paper sheets: Up to 100

Banners: Up to 20 sheets

Envelopes: Up to 15

Greeting cards: Up to 5 cards

Labels: Up to 20 sheets of labels (use only U.S. Letter or A4-sized sheets)

Photo paper: Up to 25 sheets

Index cards: Up to 40 cards

Hagaki cards: Up to 40 cards

Transparencies: Up to 25

Out tray capacity: 

FastDraft: Up to 35 sheets

Normal: Up to 50 sheets

Best: Up to 50 sheets

media size

Paper: 

U.S. Letter 216 x 279 mm (8.5 x 11 in)

Legal 216 x 356 mm (8.5 x 14 in)

Executive 184 x 267 mm (7.25 x 10.5 in)

A4 210 x 297 mm

A5 148 x 210 mm

B5 182 x 257 mm

Photo L 89 x 127 mm (Japan)

User Defined:
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Width 77 to 215 mm (3.0 to 8.5 in)

Length 127 to 355 mm (5.0 to 14 in)

Banner: 

U.S. Letter 216 x 279 mm (8.5 x 11 in)

A4 210 x 297 mm

Envelopes: 

U.S. No. 10 105 x 241 mm (4.12 x 9.5 in)

Invitation A2 111 x 146 mm (4.38 x 5.75 in)

DL 110 x 220 mm (8.66 x 4.33 in)

C6 114 x 162 mm (4.48 x 6.38in)

Index/Greeting Cards: 

76 x 127 mm (3 x 5 in)

102 x 152 mm (4 x 6 in)

127 x 203 mm (5 x 8 in)

A6 Cards: 105 x 148.5 mm

Hagaki: 100 x 148 mm

L size: 89 x 127 mm

Labels: 

U.S. Letter 216 x 279 mm (8.5 x 11 in)

A4 210 x 297 mm

Transparencies:

U.S. Letter 216 x 279 mm (8.5 x 11 in)

A4 210 x 297 mm

Photo (with tear-off tab):

102 x 152 mm (4 x 6 in)

print cartridges

Black: selection number 56, part number c6656a 

Tri-Color: selection number 57, part number c6657a 

Photo: selection number 58, part number c6658a 
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minimum system requirements

Your computer must meet the following minimum requirements:

USB connection

Mac OS 8.6 and 9.x 

PowerPC MacOS-based computer with a USB port

Minimum 64 MB RAM

10 MB (minimum) available hard-disk space

Mac OS X (version 10.1.x) and Classic 

PowerPC MacOS-based computer with a USB port

Minimum 128 MB RAM

10 MB (minimum) available hard-disk space

AppleTalk connection

PowerPC MacOS-based computer

MacOS version 8.6, 9.x or Mac OS X (version 10.1.x)

Minimum 64 MB

10 MB (minimum) available hard-disk space
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minimum printing margins

The printer cannot print outside a designated area of the page. Minimum print margins 
for common media types are shown below.

A4 paper

Left and Right Margins: 3.4 mm (0.134 in)

Top Margin: 1.8 mm (0.07 in)

Bottom Margin: 11.7 mm (0.46 in)

letter, legal, and executive paper

Left and Right Margins: 6.4 mm (0.25 in)

Top Margin: 1.8 mm (0.07 in)

Bottom Margin: 11.7 mm (0.46 in)

A5, B5, and user defined paper

Left and Right Margins: 3.2 mm (0.125 in)

Top Margin: 1.8 mm (0.07 in)

Bottom Margin: 11.7 mm (0.46 in)

cards (3 x 5 in, 4 x 6, 5 x 8, and A6)

Left and Right Margins: 3.2 mm (0.125 in)

Top Margin: 1.8 mm (0.07 in)

Bottom Margin: 11.7 mm (0.46 in)

Hagaki postcards

Left and Right Margins: 3.2 mm (0.125 in)

Top Margin: 1.8 mm (0.07 in)

Bottom Margin: 11.7 mm (0.46 in)

envelopes
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Left and Right Margins: 3.2 mm (0.125 in)

Top Margin: 1.8 mm (0.07 in)

Bottom Margin: 11.7 mm (0.46 in)

banners - A4 (210 x 297 mm [8.27 x 11.7 in])

Left and Right Margins: 3.4 mm (0.134 in)

Top Margin: 1.8 mm (0.07 in)

Bottom Margin: 11.7 mm (0.46 in)

Between Page Margin: 0.0 mm (0.0 in)

banners - letter (216 x 279 mm [8.5 x 11 in])

Left and Right Margins: 6.4 mm (0.25 in)

Top Margin: 1.8 mm (0.07 in)

Bottom Margin: 11.7 mm (0.46 in)

Between Page Margin: 0.0 mm (0.0 in)
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environmental statement

Hewlett-Packard continuously improves the design processes of its deskjet printers to 
minimize the negative impact on the office environment and on the communities where 
printers are manufactured, shipped, and used.

reduction and elimination

Paper use: The printer’s automatic/manual two-sided printing capability reduces paper 
usage and the resulting demands on natural resources. This printer is suited for the use 
of recycled papers in accordance with DIN 19 309.

Recycled paper: All paper documentation for this printer is printed on chlorine-free 
recycled paper.

Ozone: Ozone-depleting chemicals such as CFCs have been eliminated from Hewlett-
Packard's manufacturing processes.

recycling

Design for recycling has been incorporated into this printer. The number of materials has 
been kept to a minimum while ensuring proper functionality and reliability. Dissimilar 
materials have been designed to separate easily. Fasteners and other connections are 
easy to locate, access, and remove using common tools. High priority parts have been 
designed to access quickly for efficient disassembly and repair.

Printer packaging: The packaging materials for this printer have been selected to 
provide maximum protection for the least cost possible, while attempting to minimize 
environmental impact and facilitate recycling. The rugged design of the HP Deskjet 
printer assists in minimizing both packaging materials and damage rates.

Plastic parts: All major plastics and plastic parts are marked according to international 
standards. All plastic parts used in the printer housing and chassis are technically 
recyclable and all use a single polymer.

Product longevity: To ensure the longevity of your HP Deskjet printer, HP provides the 
following:

●     Extended warranty: See limited warranty.

●     Replacement parts and consumables are available for three (3) years after 
production has stopped (five (5) years in Germany).

●     Product take-back: To return this product to HP at the end of its useful life, 
go to www.hp.com/go/recycle. To return empty print cartridges to HP, see hp 
print cartridge recovery program. 

energy consumption

This printer was designed with energy conservation in mind. This printer averages 4 
watts in stand-by mode. Not only does this save natural resources, but it also saves 
money without affecting the high performance of the printer.
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This product qualifies for the ENERGY STAR® Program (U.S. and Japan). ENERGY STAR 
is a voluntary program established to encourage the development of energy-efficient 
office products.

 

ENERGY STAR is a US registered service mark of the USEPA. As an ENERGY STAR 
partner, Hewlett-Packard Company has determined that this product meets ENERGY 
STAR Guidelines for energy efficiency.

Energy consumption in off-mode: When the printer is off, a minimal amount of 
energy is still being consumed. Energy consumption can be prevented by turning the 
printer power off, then disconnecting the end of the printer power cord from the 
electrical source.

file:///C|/Projects/Newport/Mac_UG_ROW/ug_environmental_fs.html (2 of 2) [5/9/2002 10:24:23 AM]

137



print cartridge recovery 

print cartridge recovery 

Customers interested in recycling their genuine HP print cartridges can participate in 
HP's empty print cartridge return and recycle program. HP offers this program in the 
United States, Puerto Rico, France, Germany, and Singapore, more countries than any 
other print cartridge manufacturer in the world. This program is provided as a free 
service to HP customers as an environmentally sound solution for these products at end-
of life. 

To participate, simply request postage-paid return envelopes or bulk boxes via the Web 
at www.hp.com/go/recycle. Customers will be asked for their name, phone number, 
address, and how many bulk boxes or envelopes they would like. Postage-paid 
envelopes and/or bulk boxes will be shipped within two days. 

Because HP's unique recycling processes are very sensitive to material contamination, 
we cannot take back and recycle cartridges from other manufacturers. The end products 
of the recycling process are used in the manufacture of new products, and HP must 
ensure the composition of the material is consistent. To do that, we recycle only HP 
original cartridges. This program does not extend to refilled cartridges. 

Returned cartridges are separated for purification into raw materials for use in other 
industries to manufacture new products. Examples of products made from recycled HP 
print cartridge materials include automobile parts, trays used in microchip fabrication 
processes, copper wire, steel plates, and the precious materials used in electronics. 
Depending on the model, HP is able to recycle up to 65% of the print cartridge by 
weight. The remaining parts that cannot be recycled (ink, foam and composite parts) are 
disposed of in an environmentally responsible manner. 
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limited warranty

region software printer

North America (including Canada) 90 days 1 year 

Asia Pacific 90 days 1 year

Europe 90 days 1 year

Latin America 90 days 1 year 

extent of limited warranty

Hewlett-Packard (HP) warrants to the end-user customer that the HP products specified 
above will be free from defects in materials and workmanship for the duration specified 
above, which duration begins on the date of purchase by the customer. Customer is 
responsible for maintaining proof of date of purchase. 

1.  For software products, HP's limited warranty applies only to a failure to execute 
programming instructions. HP does not warrant that the operation of any product 
will be uninterrupted or error free. 

2.  HP's limited warranty covers only those defects which arise as a result of normal 
use of the product, and do not apply to any: 

❍     Improper or inadequate maintenance or modification; 

❍     Software, interfacing, media, parts, or supplies not provided or 
supported by HP; or 

❍     Operation outside the product's specifications. 

❍     For HP printer products, the use of a non-HP ink cartridge or a refilled 
ink cartridge does not affect either the warranty to the customer or any 
HP support contract with the customer. However, if printer failure or 
damage is attributable to the use of a non-HP or refilled ink cartridge, 
HP will charge its standard time and materials charges to service the 
printer for the particular failure or damage. 
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3.  If HP receives, during the applicable warranty period, notice of a defect in any 
software, media, or ink cartridge covered by HP's warranty, HP shall replace the 
defective product. If HP receives notice of a defect in any hardware product 
covered by HP's warranty during the applicable warranty period, HP shall either 
repair or replace the defective product at HP's option. 

4.  If HP is unable to repair or replace, as applicable, a defective product covered by 
HP's warranty, HP shall, within a reasonable time after being notified of the 
defect, refund the purchase price of the product. 

5.  HP shall have no obligation to repair, replace, or refund until the customer returns 
the defective product to HP. 

6.  Any replacement product may be either new or like-new, provided that it has 
functionality at least equal to that of the product being replaced. 

7.  HP's limited warranty is valid in any country where the covered HP product is 
distributed by HP except for the Middle-East, Africa, Argentina, Brazil, Mexico, 
Venezuela, and France's “Departements D'Outre-Mer”; for those excepted areas, 
the warranty is valid only in the country of purchase. Contracts for additional 
warranty services, such as on-site service, may be available from any authorized 
HP service facility where the product is distributed by HP or by an authorized 
importer. 

8.  Any applicable print cartridge warranty shall not apply to HP print cartridges that 
have been refilled, remanufactured, refurbished, misused, or tampered with in 
any way. 

limitations of warranty

1.  TO THE EXTENT ALLOWED BY LOCAL LAW, NEITHER HP NOR ITS THIRD PARTY 
SUPPLIERS MAKE ANY OTHER WARRANTY OR CONDITION OF ANY KIND, 
WHETHER EXPRESS OR IMPLIED, WITH RESPECT TO THE HP PRODUCTS, AND 
SPECIFICALLY DISCLAIM THE IMPLIED WARRANTIES OR CONDITIONS OF 
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR 
PURPOSE. 

limitations of liability

1.  To the extent allowed by local law, the remedies provided in this Warranty 
Statement are the customer's sole and exclusive remedies. 

2.  TO THE EXTENT ALLOWED BY LOCAL LAW, EXCEPT FOR THE OBLIGATIONS 
SPECIFICALLY SET FORTH IN THIS WARRANTY STATEMENT, IN NO EVENT WILL 
HP OR ITS THIRD PARTY SUPPLIERS BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES, WHETHER BASED ON CONTRACT, 
TORT, OR ANY OTHER LEGAL THEORY AND WHETHER ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. 

local law
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1.  This Warranty Statement gives the customer specific legal rights. The customer 
may also have other rights which vary from state to state in the United States, 
from province to province in Canada, and from country to country elsewhere in 
the world. 

2.  To the extent that this Warranty Statement is inconsistent with local law, this 
Warranty Statement shall be deemed modified to be consistent with such local 
law. Under such local law, certain disclaimers and limitations of this Warranty 
Statement may not apply to the customer. For example, some states in the 
United States, as well as some governments outside the United States (including 
provinces in Canada), may: 

❍     Preclude the disclaimers and limitations in this Warranty Statement from 
limiting the statutory rights of a consumer (e.g., the United Kingdom); 

❍     Otherwise restrict the ability of a manufacturer to enforce such 
disclaimers or limitations; or 

❍     Grant the customer additional warranty rights, specify the duration of 
implied warranties which the manufacturer cannot disclaim, or not allow 
limitations on the duration of implied warranties. 

3.  FOR CONSUMER TRANSACTIONS IN AUSTRALIA AND NEW ZEALAND, THE TERMS 
IN THIS WARRANTY STATEMENT, EXCEPT TO THE EXTENT LAWFULLY PERMITTED, 
DO NOT EXCLUDE, RESTRICT, OR MODIFY, AND ARE IN ADDITION TO, THE 
MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF HP PRODUCTS 
TO SUCH CUSTOMERS. 

obtaining a warranty extension 

If you would like to extend your warranty coverage beyond the limited 
warranty period, use one of the following options: 

●     Consult your reseller to get extended coverage. To find HP resellers in the 
U.S., visit HP's service locator at www.hp.com/service_locator. 

●     If your reseller does not offer service contracts, call HP directly and ask about 
our HP service agreements. In the U.S. call (800) 446-0522; in Canada call 
(800) 268-1221. For HP service agreements outside of the U.S. and Canada, 
contact your local HP sales office. 
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regulatory notices 

hewlett-packard company

This device complies with part 15 of the FCC Rules. Operation is subject to the following 
two conditions:

●     This device may not cause harmful interference, and 

●     This device must accept any interference received, including interference that 
may cause undesired operation. 

Pursuant to part 15.21 of the FCC Rules, any changes or modifications to this equipment 
not expressly approved by Hewlett-Packard Company may cause harmful interference, 
and void your authority to operate this equipment. Use of a shielded data cable is 
required to comply with the Class B limits of part 15 of the FCC Rules.

For further information, contact:

Hewlett-Packard Company

Manager of Corporate Product Regulations

3000 Hanover Street

Palo Alto, CA 94304

(605) 857-1501

note

This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to part 15 of the FCC rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, can cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the 
user is encouraged to try to correct the interference by one or more of the following 
measures:

●     Reorient or relocate the receiving antenna. 

●     Increase the separation between the equipment and the receiver. 

●     Connect the equipment into an outlet on a circuit different from that to which 
the receiver is connected. 

●     Consult the dealer or an experienced radio/TV technician for help. 

LED indicator statement
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The display LEDs meet the requirements of EN 60825-1.
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